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About this manual 
 

This manual describes the System 200V CPU 21x-2BT13 from VIPA. Here 
you may find every information for commissioning and operation. 
 

Chapter 1: Basics and Assembly 
The focus of this chapter is on the introduction of the VIPA System 200V. 
Here you will find the information required to assemble and wire a controller 
system consisting of System 200V components. 
Besides the dimensions the general technical data of System 200V will be 
found.   
 
Chapter 2: Hardware description  
Here the hardware components of the CPU are described. The technical 
data are at the end of the chapter. 
 
Chapter 3: Deployment CPU 21x-2BT13 
This chapter describes the deployment of the CPU in the System 200V. 
The description refers directly to the CPU and to the deployment in 
connection with peripheral modules, mounted on a profile rail together with 
the CPU at the backplane bus. 
 
Chapter 3: Deployment Ethernet communication 
In this chapter the communication via Ethernet is described. Please regard 
the chapter "Fast introduction" where you will find every information 
compressed required for the project engineering of the CPU 21x-2BT13 
with CP 243. After the fast introduction, the mentioned steps are described 
in detail. 
 

Overview 
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This manual describes the System 200V CPU 21x-2BT13 from VIPA.  
It contains a description of the construction, project implementation and 
usage. 
This manual is part of the documentation package with order number  
HB97E_CPU and relevant for:  
Product Order number as of state: 
  CPU-HW CPU-FW CP-FW 
CPU 21xNET VIPA CPU 21x-2BT13 01 V 4.1.7 V 2.7.4 
 

The manual is targeted at users who have a background in automation 
technology. 
 

The manual consists of chapters. Every chapter provides a self-contained 
description of a specific topic. 
 

The following guides are available in the manual: 
• an overall table of contents at the beginning of the manual 
• an overview of the topics for every chapter 
 

The manual is available in: 
• printed form, on paper 
• in electronic form as PDF-file (Adobe Acrobat Reader) 
 

Important passages in the text are highlighted by following icons and 
headings: 
 

Danger! 
Immediate or likely danger. 
Personal injury is possible. 
 

Attention! 
Damages to property is likely if these warnings are not heeded. 
 

Note! 
Supplementary information and useful tips. 
 

 

Objective and 
contents 

Target audience 

Structure of the 
manual 

Guide to the 
document 

Availability 

Icons 
Headings 
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Safety information 
 

The CPU 21x is constructed and produced for: 
• all VIPA System 200V components 
• communication and process control 
• general control and automation applications 
• industrial applications 
• operation within the environmental conditions specified in the technical 

data 
• installation into a cubicle 
 

Danger! 
This device is not certified for applications in 
• in explosive environments (EX-zone) 
 

The manual must be available to all personnel in the 
• project design department 
• installation department 
• commissioning 
• operation 
 

The following conditions must be met before using or commissioning 
the components described in this manual: 
 
• Hardware modifications to the process control system should only be 

carried out when the system has been disconnected from power! 
 
• Installation and hardware modification only by properly trained 

personnel. 
 
• The national rules and regulations of the respective country must be 

satisfied (installation, safety, EMC ...) 
 

National rules and regulations apply to the disposal of the unit! 
 

Applications 
conforming with 
specifications 

 

Documentation 

 

Disposal 
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Chapter 1 Basics and Assembly 
 

The focus of this chapter is on the introduction of the VIPA System 200V. 
Here you will find the information required to assemble and wire a controller 
system consisting of System 200V components. 
Besides the dimensions the general technical data of System 200V will be 
found.   
 

 

Topic     Page 
Chapter 1 Basics and Assembly ..................................................... 1-1 

Safety Information for Users................................................................. 1-2 
System conception ............................................................................... 1-3 
Dimensions .......................................................................................... 1-5 
Installation............................................................................................ 1-7 
Demounting and module exchange .................................................... 1-11 
Wiring................................................................................................. 1-12 
Installation guidelines ......................................................................... 1-14 
General data ...................................................................................... 1-17 

 

 

Overview 

Contents 
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Safety Information for Users 
 

VIPA modules make use of highly integrated components in MOS-
Technology. These components are extremely sensitive to over-voltages 
that can occur during electrostatic discharges. 
The following symbol is attached to modules that can be destroyed by 
electrostatic discharges. 
 

 
 
The Symbol is located on the module, the module rack or on packing 
material and it indicates the presence of electrostatic sensitive equipment. 
It is possible that electrostatic sensitive equipment is destroyed by energies 
and voltages that are far less than the human threshold of perception. 
These voltages can occur where persons do not discharge themselves 
before handling electrostatic sensitive modules and they can damage 
components thereby, causing the module to become inoperable or 
unusable. 
Modules that have been damaged by electrostatic discharges can fail after 
a temperature change, mechanical shock or changes in the electrical load. 
Only the consequent implementation of protection devices and meticulous 
attention to the applicable rules and regulations for handling the respective 
equipment can prevent failures of electrostatic sensitive modules. 
 

Modules must be shipped in the original packing material. 
 

 
When you are conducting measurements on electrostatic sensitive modules 
you should take the following precautions: 
• Floating instruments must be discharged before use. 
• Instruments must be grounded. 
Modifying electrostatic sensitive modules you should only use soldering 
irons with grounded tips. 
 

Attention! 
Personnel and instruments should be grounded when working on 
electrostatic sensitive modules. 
 
 

Handling of 
electrostatic 
sensitive modules 

Shipping of 
electrostatic 
sensitive modules 

Measurements and 
alterations on 
electrostatic 
sensitive modules 
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System conception 
 

The System 200V is a modular automation system for assembly on a 
35mm profile rail. By means of the peripheral modules with 4, 8 and 16 
channels this system may properly be adapted matching to your 
automation tasks. 
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The System 200V consists of the following components: 
• Head modules like CPU and bus coupler 
• Periphery modules like I/O, function und communication modules 
• Power supplies  
• Extension modules 
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With a head module CPU respectively bus 
interface and DC 24V power supply are 
integrated to one casing. 
Via the integrated power supply the CPU 
respectively bus interface is power 
supplied as well as the electronic of the 
connected periphery modules. 
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The modules are direct installed on a 
35mm profile rail and connected to the 
head module by a bus connector, which 
was mounted on the profile rail before. 
Most of the periphery modules are 
equipped with a 10pin respectively 18pin 
connector. This connector provides the 
electrical interface for the signaling and 
supplies lines of the modules. 
 

Overview 

Components 

Head modules 

Periphery modules 
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With the System 200V the DC 24V power 
supply can take place either externally or 
via a particularly for this developed power 
supply. 
The power supply may be mounted on the 
profile rail together with the System 200V 
modules. It has no connector to the back-
plane bus. 
 

 

CM 201
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X 2
3 4

X2.X1.

 

The expansion modules are complemen-
tary modules providing 2- or 3wire con-
nection facilities.  
The modules are not connected to the 
backplane bus. 
 

 

• Profile rail 35mm  
• Dimensions of the basic enclosure: 
 1tier width: (HxWxD) in mm: 76x25.4x74 in inches: 3x1x3 
 2tier width: (HxWxD) in mm: 76x50.8x74 in inches: 3x2x3 
 

Please note that you can only install header modules, like the CPU, the PC 
and couplers at slot 1 or 1 and 2 (for double width modules). 
 

[1] Head module 
(double width) 

[2] Head module  
(single width)  

[3] Periphery module 
[4] Guide rails 

1 2

4

3

0 1

Clack

D
P

 

 
Note 
A maximum of 32 modules can 
be connected at the back plane 
bus. Take attention that here the 
maximum sum current of 3.5A
is not exceeded. 
Please install modules with a 
high current consumption direct-
ly beside the header module.  
 

 

Power supplies 

Expansion 
modules 

Structure/ 
dimensions 

Installation 
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Dimensions 
 

1tier width (HxWxD) in mm: 76 x 25.4 x 74 
2tier width (HxWxD) in mm: 76 x 50.8 x 74 
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Dimensions 
Basic enclosure 

Installation 
dimensions 

Installed and wired 
dimensions 
In- / Output 
modules 
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Function modules/ 
Extension modules 

CPUs (here with 
EasyConn from 
VIPA) 
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Installation 
 

The modules are each installed on a 35mm profile rail and connected via a 
bus connector. Before installing the module the bus connector is to be 
placed on the profile rail before. 
 

For installation the following 35mm profile rails may be used: 
 

35 mm
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m
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Order number Label Description 
290-1AF00 35mm profile rail Length 2000mm, height 15mm
290-1AF30 35mm profile rail Length 530mm, height 15mm 
 

System 200V modules communicate via a backplane bus connector. The 
backplane bus connector is isolated and available from VIPA in of 1-, 2-, 4- 
or 8tier width. 
The following figure shows a 1tier connector and a 4tier connector bus: 
 

 
 
The bus connector is to be placed on the profile rail until it clips in its place 
and the bus connections look out from the profile rail. 
Order number Label Description 
290-0AA10 Bus connector 1tier 
290-0AA20 Bus connector 2tier 
290-0AA40 Bus connector 4tier 
290-0AA80 Bus connector 8tier 

                           
 

General 

Profile rail 

Bus connector 
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The following figure shows the installation of a 4tier width bus connector in 
a profile rail and the slots for the modules.  
The different slots are defined by guide rails.  
 

[1] Header module  
(double width) 

[2] Header module  
(single width) 

[3] Peripheral module 
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[4] Guide rails 

       

• Use bus connectors as long as possible. 
• Sort the modules with a high current consumption right beside the 

header module. In the service area of www.vipa.com a list of current 
consumption of every System 200V module can be found. 

 

Installation on a 
profile rail  

Assembly regarding 
the current 
consumption 
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hoizontal assembly

lying assembly

vertical
assembly

0 1

0
1

Please regard the allowed environmental temperatures: 

• horizontal assembly: from 0 to 60°C 
• vertical assembly: from 0 to 40°C 
• lying assembly: from 0 to 40°C 
 
The horizontal assembly always starts at the left side with 
a header module, then you install the peripheral modules 
beside to the right.  
You may install up to 32 peripheral modules.  
 
 
 

80
 m

m
60

 m
m

 

Please follow these rules during the assembly! 
• Turn off the power supply before you install or remove 

any modules!  
• Make sure that a clearance of at least 60mm exists 

above and 80mm below the middle of the profile rail. 
 

• Every row must be completed from left to right and it 
has to start with a header module. 

 
[1] Header module (double width) 
[2] Header module (single width) 

1 2

4

3

 [3] Peripheral modules 
 [4] Guide rails 

 
 • Modules are to be installed side by side. Gaps are not 

permitted between the modules since this would 
interrupt the backplane bus. 

• A module is only installed properly and connected 
electrically when it has clicked into place with an 
audible click. 

• Slots after the last module may remain unoccupied.  
 

 
Note! 
A maximum of 32 modules can be connected at the back plane bus. Take 
attention that here the maximum sum current of 3.5A is not exceeded.  

Assembly 
possibilities 
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• Install the profile rail. Make sure that a clearance of at least 60mm 
exists above and 80mm below the middle of the profile rail. 

 
 
 
 
 
 
• Press the bus connector into the profile rail until it clips securely into 

place and the bus-connectors look out from the profile rail. This 
provides the basis for the installation of your modules. 

 
 
 
 
• Start at the outer left location with the installation of your header 

module and install the peripheral modules to the right of this. 
[1] Header module  

(double width) 
[2] Header module 

(single width) 
[3] Peripheral module 

1 2

4

3

[4] Guide rails 

• Insert the module that you are installing into the profile rail at an angle 
of 45 degrees from the top and rotate the module into place until it 
clicks into the profile rail with an audible click. The proper connection 
to the backplane bus can only be guaranteed when the module has 
properly clicked into place. 

Clack  

 

Attention! 
Power must be turned off before modules are 
installed or removed! 
 

 

Assembly 
procedure 
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Demounting and module exchange 
 

1

2

3

4

5

 
 
 

 
 

• Remove if exists the wiring to the module, by pressing both 
locking lever on the connector and pulling the connector. 

 
   
 
 
• The casing of the module has a spring loaded clip at the 

bottom by which the module can be removed. 
 
 
 

 
 
• The clip is unlocked by pressing the screwdriver in an upward 

direction. 
 
 
 
 
 
• Withdraw the module with a slight rotation to the top. 
 
 
 
 
 
 
 
 
 
 
 
 
Attention! 
Power must be turned off before modules are installed or 
removed! 
Please regard that the backplane bus is interrupted at the point 
where the module was removed! 
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Wiring 
 

Most peripheral modules are equipped with a 10pole or a 18pole connector. 
This connector provides the electrical interface for the signaling and supply 
lines of the modules. 
The modules carry spring-clip connectors for interconnections and wiring. 
The spring-clip connector technology simplifies the wiring requirements for 
signaling and power cables.  
In contrast to screw terminal connections, spring-clip wiring is vibration 
proof. The assignment of the terminals is contained in the description of the 
respective modules. 
You may connect conductors with a diameter from 0.08mm2 up to 2.5mm2 
(max. 1.5mm2 for 18pole connectors). 
The following figure shows a module with a 10pole connector. 
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[1] 
[2] 
[3] 
[4] 
[5] 

Locking lever 
Pin no. at the module 
Pin no. at the connector 
Wiring port 
Opening for screwdriver 
 

 

Note! 
The spring-clip is destroyed if you push the screwdriver into the wire port!  
Make sure that you only insert the screwdriver into the square hole of the 
connector! 
 

Overview 
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• Install the connector on the module until it locks with an audible click. 
For this purpose you press the two clips together as shown. 
The connector is now in a permanent position and can easily be wired. 

 
 
The following section shows the wiring procedure from top view. 
 

 

• Insert a screwdriver at an angel into the square opening as shown. 
• Press and hold the screwdriver in the opposite direction to open the 

contact spring. 
 
 
 
 
 
• Insert the stripped end of the wire into the round opening. You can use 

wires with a diameter of 0.08mm2 to 2.5mm2  
(1.5mm2 for 18pole connectors). 

 
 
 
 
 
 
 
• By removing the screwdriver the wire is connected safely with the plug 

connector via a spring. 
 

 

Note! 
Wire the power supply connections first followed by the signal cables 
(inputs and outputs). 
 
 

Wiring procedure 
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Installation guidelines 
 

The installation guidelines contain information about the interference free 
deployment of System 200V systems. There is the description of the ways, 
interference may occur in your control, how you can make sure the 
electromagnetic digestibility (EMC), and how you manage the isolation. 
 

Electromagnetic digestibility (EMC) means the ability of an electrical device, 
to function error free in an electromagnetic environment without being 
interferenced res. without interferencing the environment. 
All System 200V components are developed for the deployment in hard 
industrial environments and fulfill high demands on the EMC. Nevertheless 
you should project an EMC planning before installing the components and 
take conceivable interference causes into account. 
 

Electromagnetic interferences may interfere your control via different ways: 
• Electromagnetic fields (RF coupling) 
• Magnetic fields with power frequency 
• I/O signal conductors 
• Bus system 
• Current supply 
• Protected earth conductor 
 
Depending on the spreading medium (lead bound or lead free) and the 
distance to the interference cause, interferences to your control occur by 
means of different coupling mechanisms. 
One differs: 
• galvanic coupling 
• capacitive coupling 
• inductive coupling 
• radiant coupling 

 
 

General 

What means EMC? 

Possible 
interference 
causes 
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In the most times it is enough to take care of some elementary rules to 
guarantee the EMC. Please regard the following basic rules when installing 
your PLC. 
• Take care of a correct area-wide grounding of the inactive metal parts 

when installing your components. 
- Install a central connection between the ground and the protected 

earth conductor system. 
- Connect all inactive metal extensive and impedance-low. 
- Please try not to use aluminum parts. Aluminum is easily oxidizing 

and is therefore less suitable for grounding. 
• When cabling, take care of the correct line routing. 

- Organize your cabling in line groups (high voltage, current supply, 
signal and data lines). 

- Always lay your high voltage lines and signal res. data lines in 
separate channels or bundles. 

- Route the signal and data lines as near as possible beside ground 
areas (e.g. suspension bars, metal rails, tin cabinet). 

• Proof the correct fixing of the lead isolation. 
- Data lines must be laid isolated (for details see below). 
- Analog lines must be laid isolated. When transmitting signals with 

small amplitudes the one sided laying of the isolation may be 
favorable. 

- Lay the line isolation extensively on an isolation/protected earth con-
ductor rail directly after the cabinet entry and fix the isolation with 
cable clamps. 

- Make sure that the isolation/protected earth conductor rail is 
connected impedance-low with the cabinet. 

- Use metallic or metalized plug cases for isolated data lines. 
• In special use cases you should appoint special EMC actions. 

- Wire all inductivities with erase links, which are not addressed by the 
System SLIO modules. 

- For lightening cabinets you should avoid luminescent lamps. 
• Create a homogeneous reference potential and ground all electrical 

operating supplies when possible. 
- Please take care for the targeted employment of the grounding 

actions. The grounding of the PLC is a protection and functionality 
activity. 

- Connect installation parts and cabinets with the System SLIO in star 
topology with the isolation/protected earth conductor system. So you 
avoid ground loops. 

- If potential differences between installation parts and cabinets occur, 
lay sufficiently dimensioned potential compensation lines. 

Basic rules for 
EMC 
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Electrical, magnetically and electromagnetic interference fields are 
weakened by means of an isolation, one talks of absorption. 
Via the isolation rail, that is connected conductive with the rack, 
interference currents are shunt via cable isolation to the ground. Hereby 
you have to make sure, that the connection to the protected earth conduc-
tor is impedance-low, because otherwise the interference currents may 
appear as interference cause. 
 
When isolating cables you have to regard the following: 
• If possible, use only cables with isolation tangle. 
• The hiding power of the isolation should be higher than 80%. 
• Normally you should always lay the isolation of cables on both sides. 

Only by means of the both-sided connection of the isolation you achieve 
high quality interference suppression in the higher frequency area. 
Only as exception you may also lay the isolation one-sided. Then you 
only achieve the absorption of the lower frequencies. A one-sided 
isolation connection may be convenient, if: 
- the conduction of a potential compensating line is not possible 
- analog signals (some mV res. µA) are transferred 
- foil isolations (static isolations) are used. 

• With data lines always use metallic or metalized plugs for serial 
couplings. Fix the isolation of the data line at the plug rack. Do not lay 
the isolation on the PIN 1 of the plug bar! 

• At stationary operation it is convenient to strip the insulated cable 
interruption free and lay it on the isolation/protected earth conductor line. 

• To fix the isolation tangles use cable clamps out of metal. The clamps 
must clasp the isolation extensively and have well contact. 

• Lay the isolation on an isolation rail directly after the entry of the cable in 
the cabinet. Lead the isolation further on to the System 200V module 
and don't lay it on there again! 

 

Please regard at installation! 
At potential differences between the grounding points, there may be a 
compensation current via the isolation connected at both sides. 
Remedy: Potential compensation line. 
 

 
 

Isolation of 
conductors 
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General data 
 

• Profile rail 35mm  
• Peripheral modules with recessed labelling 
• Dimensions of the basic enclosure: 
 1tier width: (HxWxD) in mm: 76x25.4x74 in inches: 3x1x3 
 2tier width: (HxWxD) in mm: 76x50.8x74 in inches: 3x2x3 
 

• Wiring by means of spring pressure connections (CageClamps) at the 
front-facing connector, core cross-section 0.08 ... 2.5mm2 or 1.5mm2 
(18pole plug) 

• Complete isolation of the wiring when modules are exchanged 
• Every module is isolated from the backplane bus 

Structure/ 
dimensions 

Reliability 
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Conformity and approval 
Conformity 
CE 2006/95/EC Low-voltage directive 
 2004/108/EC EMC directive 
Approval 
UL UL 508 Approval for USA and Canada 
others 
RoHS 2011/65/EU Product is lead-free; Restriction of the use of 

certain hazardous substances in electrical and 
electronic equipment 

 

Protection of persons and device protection 
Type of protection - IP20 
Electrical isolation 
to the field bus - electrically isolated 
to the process level - electrically isolated 
Insulation resistance EN 61131-2 - 
Insulation voltage to reference earth 
Inputs / outputs - AC / DC 50V, test voltage AC 500V 
Protective measures - against short circuit 

 

Environmental conditions to EN 61131-2 
Climatic 
Storage / transport EN 60068-2-14 -25…+70°C 
Operation 
Horizontal installation EN 61131-2 0…+60°C 
Vertical installation EN 61131-2 0…+60°C 
Air humidity EN 60068-2-30 RH1 (without condensation, rel. humidity 10…95%)
Pollution EN 61131-2 Degree of pollution 2 
Mechanical 
Oscillation EN 60068-2-6 1g, 9Hz ... 150Hz 
Shock EN 60068-2-27 15g, 11ms 

 

Mounting conditions 
Mounting place - In the control cabinet 
Mounting position - Horizontal and vertical 

 

EMC Standard Comment 
Emitted 
interference 

EN 61000-6-4 Class A (Industrial area) 

EN 61000-6-2   Industrial area 

EN 61000-4-2 ESD 
8kV at air discharge (degree of severity 3), 
4kV at contact discharge (degree of severity 2) 

EN 61000-4-3 HF field immunity (casing) 
80MHz … 1000MHz, 10V/m, 80% AM (1kHz) 
1.4GHz ... 2.0GHz, 3V/m, 80% AM (1kHz) 
2GHz ... 2.7GHz, 1V/m, 80% AM (1kHz) 

EN 61000-4-6 HF conducted  
150kHz … 80MHz, 10V, 80% AM (1kHz) 

EN 61000-4-4 Burst, degree of severity 3 

Noise immunity 
zone B  

EN 61000-4-5 Surge, installation class 3 *) 
*) Due to the high-energetic single pulses with Surge an appropriate external protective circuit with 

lightning protection elements like conductors for lightning and overvoltage is necessary. 

 

General data 
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Chapter 2  Hardware description 
 

Here the hardware components of the CPU are described. The technical 
data are at the end of the chapter. 
 

 

Topic     Page 
Chapter 2 Hardware description...................................................... 2-1 

Properties............................................................................................. 2-2 
Structure .............................................................................................. 2-3 
Technical data...................................................................................... 2-7 

 

Overview 

Contents 
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Properties 
 

• Instruction set compatible with Siemens STEP 7 
• Configuration by means of the Siemens SIMATIC manager 
• Integrated V-Bus controller for controlling System 200V peripherals 
• Integrated 24V power supply 
• Total address range: 1024Byte inputs, 1024Byte outputs 
 (128Byte process image each) 
• 96 / 128kByte of work memory "on board" 
• 144 / 192kByte of load memory "on board" 
• MMC slot (for user program) 
• Battery backed clock 
• MP2I interface for data transfer 
• Status LEDs for operating mode and diagnostics 
• Integrated Ethernet CP 243 (compatible to CP 343) 

- Direct connection to twisted pair Ethernet via RJ45 jack 
- CP configurable with NetPro from Siemens 
- Protocols: TCP/IP, UDP and RFC1006 
- Transfer rate 10/100MBit/s 
- PG/OP channel 
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Type Order number Description 
CPU 214NET VIPA 214-2BT13 PLC CPU 214 with Ethernet and 

96/144kByte of work/load memory 
CPU 215NET VIPA 215-2BT13 PLC CPU 215 with Ethernet and  

128/192kByte of work/load memory 
 

 

CPU 21x-2BT13 

Order data 
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Structure 
 

[1] Operating mode switch 
[2] LEDs of the CPU 
[3] Slot for MMC  

memory card 
[4] MP2I interface 
[5] Slot for DC 24V  

power supply 
[6] LEDs of the CP 243 

respectively Ethernet 
PG/OP channel 

Front view  
CPU 21x-2BT13 
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[7] Ethernet interface for CP 
243 respectively Ethernet 
PG/OP channel 
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Interfaces 
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The CPU has an internal power supply. This is connected to an external 
supply voltage via two terminals located on the front of the unit.  
The power supply requires DC 24V (20.4 ... 28.8V). In addition to the 
electronic circuitry of the CPU this supply voltage is used for the modules 
connected to the backplane bus.  
The electronic circuitry of the CPU is not dc-insulated from the supply 
voltage. The power supply is protected against reverse polarity and short 
circuits. 
 

Note! 
Please ensure that the polarity of the supply voltage is correct. 
 

 

The MPI unit provides the link for the data transfer between the CPU and 
the PC. Via bus communication you are able to exchange programs and 
data between different CPUs that are linked over MPI. 
For a serial exchange between the partners you normally need a special 
MPI-converter. But now you are also able to use the VIPA "Green Cable" 
(Order-No. VIPA 950-0KB00), which allows you to establish a serial peer-
to-peer connection over the MPI interface.  
Please regard the "Hints for the deployment of the MPI interface" in chapter 
"Deployment CPU 21x". 
 

 

8pin RJ45 jack 
The CP 243 offers you a communication processor.  This serves the 
following possibilities for connections: 
• PG/OP channels (each 1 connection is reserved for PG and OP) 
• Productive connections configurable with Siemens NetPro respectively 

by user program   
 
The project engineering happens as CP 343-1EX11. Via the RJ45 jack you 
may connect the CP 243 to Twisted-Pair-Ethernet. 
 

Power supply 

     

MP2I interface 

Ethernet  
interface 
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The CPUs have an integrated work and a load memory. The memories are 
battery-buffered. 
 
Order number Work memory Load memory 
VIPA 214-2BT13 96kByte 144kByte 
VIPA 215-2BT13 128kByte 192kByte 

 
In the load memory there are program code and blocks stored together with 
the header information. 
The program parts and blocks, which are relevant for the running program, 
are loaded to the work memory during the program sequence. 
 

 

 
 
 

RN

ST

MR 

With the operating mode switch you may switch the CPU between STOP 
and RUN.  
During the transition from STOP to RUN the operating mode START-UP is 
driven by the CPU. 
By Switching to MR (Memory Reset) you request an overall reset  with 
following load from MMC, if a project there exists. 
 
 

 

 

You may install a VIPA MMC memory card in this slot as external storage 
device (Order No.: VIPA 953-0KX10). 
The access to the MMC takes always place after an overall reset. 
 

 

A rechargeable battery is installed on every CPU 21x to safeguard the 
contents of the RAM when power is removed. This battery is also used to 
buffer the internal clock. 
The rechargeable battery is maintained by a charging circuit that receives 
its power from the internal power supply and that maintain the clock and 
RAM for a max. period of 30 days.  
 

Attention! 
Due to a long storage of the CPU, the battery may be discharged 
excessively. Please connect the CPU at least for 24 hours to the power 
supply, to achieve the full buffer capacity. 
After a power reset and with an empty battery the CPU starts with a BAT 
error and executes an overall reset, because with an empty battery the 
RAM content is undefined. 
 

Memory 
management 

Operating mode 
switch 

MMC slot 
memory card 

Battery backup for 
clock and RAM 
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The CPU has got LEDs on its front side. In the following the usage and the 
according colors of the LEDs is described. 
 
Name Color Description 
PW green Indicates CPU power on. 
R green CPU status is RUN. 
S yellow CPU status is STOP. 

SF red Is turned on if a system error is detected  
(hardware defect) 

FC yellow Is turned on when variables are forced (fixed). 
MC yellow This LED blinks when the MMC is accessed.  

 

 

 

In addition the CPU has more LEDs that display the communication of the 
CP. The LEDs are located on the front of the left side of the housing. 
The table below shows the color and the meaning of these LEDs. 
 
Name Color Description 

RN green CP: RUN 
On: CP project is loaded 
Off: CP is reset (no project) 

ST yellow CP: STOP 
On: CP status is reset 
Off: CP Project is transferred 

IF red On: Internal CP error 
L/A green Link/Activity:   

On: physically connected to Ethernet 
Off: no physical connection to Ethernet 
Irregular flashing: Ethernet activity 

S green Transfer speed:  
On: 100MBit/s 
Off: 10MBit/s 

 
 

LEDs CPU 

LEDs CP 243 
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Technical data 
 

Order no. 214-2BT13 
Type CPU 214NET 
Technical data power supply  
Power supply (rated value) DC 24 V 
Power supply (permitted range) DC 20.4...28.8 V 
Reverse polarity protection  
Current consumption (no-load operation) 140 mA 
Current consumption (rated value) 1.5 A 
Inrush current 65 A 
I²t 0.75 A²s 
Max. current drain at backplane bus 3 A 
Power loss 6 W 
Load and working memory  
Load memory, integrated 144 KB 
Load memory, maximum 144 KB 
Work memory, integrated 96 KB 
Work memory, maximal 96 KB 
Memory divided in 50% program / 50% data - 
Memory card slot MMC-Card with max. 512 MB 
Hardware configuration  
Racks, max. 4  
Modules per rack, max. total max. 32 
Number of integrated DP master - 
Number of DP master via CP 8  
Operable function modules 32  
Operable communication modules PtP 32  
Operable communication modules LAN - 
Command processing times  
Bit instructions, min. 0.18 µs 
Word instruction, min. 0.78 µs 
Double integer arithmetic, min. 1.8 µs 
Floating-point arithmetic, min. 40 µs 
Timers/Counters and their retentive 
characteristics 

 

Number of S7 counters 256  
S7 counter remanence adjustable 0 up to 64 
S7 counter remanence adjustable C0 .. C7 
Number of S7 times 256  
S7 times remanence adjustable 0 up to 128 
S7 times remanence adjustable not retentive 
Data range and retentive characteristic  
Number of flags 8192 Bit 
Bit memories retentive characteristic adjustable adjustable 0 up to 256 
Bit memories retentive characteristic preset MB0 .. MB15 
Number of data blocks 2047  
Max. data blocks size 16 KB 
Number range DBs 1 ... 2047 
Max. local data size per execution level 1024 Byte 
Max. local data size per block 1024 Byte 
Blocks  
Number of OBs 14  
Maximum OB size 16 KB 
Total number DBs, FBs, FCs - 
Number of FBs 1024  
Maximum FB size 16 KB 
Number range FBs 0 ... 1023 

214-2BT13 



Chapter 2   Hardware description Manual VIPA System 200V 

2-8  HB97E - CPU - RE_21x-2BT13 - Rev. 14/44 

Order no. 214-2BT13 
Number of FCs 1024  
Maximum FC size 16 KB 
Number range FCs 0 ... 1023 
Maximum nesting depth per priority class 8  
Maximum nesting depth additional within an error OB 1  
Time  
Real-time clock buffered  
Clock buffered period (min.) 30 d 
Type of buffering  Vanadium Rechargeable 

Lithium Batterie 
Load time for 50% buffering period 20 h 
Load time for 100% buffering period 48 h 
Accuracy (max. deviation per day) 10 s 
Number of operating hours counter 8  
Clock synchronization - 
Synchronization via MPI - 
Synchronization via Ethernet (NTP) - 
Address areas (I/O)  
Input I/O address area 1024 Byte 
Output I/O address area 1024 Byte 
Process image adjustable - 
Input process image preset 128 Byte 
Output process image preset 128 Byte 
Input process image maximal 128 Byte 
Output process image maximal 128 Byte 
Digital inputs 8192  
Digital outputs 8192  
Digital inputs central 512  
Digital outputs central 512  
Integrated digital inputs - 
Integrated digital outputs - 
Analog inputs 512  
Analog outputs 512  
Analog inputs, central 128  
Analog outputs, central 128  
Integrated analog inputs - 
Integrated analog outputs - 
Communication functions  
PG/OP channel  
Global data communication  
Number of GD circuits, max. 4  
Size of GD packets, max. 22 Byte 
S7 basic communication  
S7 basic communication, user data per job 76 Byte 
S7 communication  
S7 communication as server  
S7 communication as client - 
S7 communication, user data per job 160 Byte 
Number of connections, max. 16  
Functionality Sub-D interfaces  
Type MP²I 
Type of interface RS485 
Connector Sub-D, 9-pin, female 
Electrically isolated - 
MPI  
MP²I (MPI/RS232)  
Point-to-point interface - 
Functionality MPI  
Number of connections, max. 16  
PG/OP channel  
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Order no. 214-2BT13 
Routing - 
Global data communication  
S7 basic communication  
S7 communication  
S7 communication as server  
S7 communication as client - 
Transmission speed, min. 19.2 kbit/s 
Transmission speed, max. 187.5 kbit/s 
Functionality RJ45 interfaces  
Type TP 
Type of interface Ethernet 10/100 MBit 
Connector RJ45 
Electrically isolated  
PG/OP channel  
Number of connections, max. 8  
Productive connections  
Ethernet communication CP  
Number of productive connections, max. 16  
Number of productive connections by Siemens 
NetPro, max. 

16  

S7 connections - 
User data per S7 connection, max. - 
TCP-connections SEND, RECEIVE, FETCH 

PASSIV, WRITE PASSIV, 
Connection of active and 
passive data handling 

User data per TCP connection, max. 64 KB 
ISO-connections SEND and RECEIVE 
User data per ISO connection, max. 8 KB 
ISO on TCP connections (RFC 1006) SEND, RECEIVE, FETCH 

PASSIV, WRITE PASSIV, 
Connection of active and 
passive data handling 

User data per ISO on TCP connection, max. 32 KB 
UDP-connections SEND and RECEIVE 
User data per UDP connection, max. 2 KB 
UDP-multicast-connections SEND and RECEIVE 

(max. 16 Multicast groups) 
UDP-broadcast-connections SEND 
Datasizes  
Input bytes 0 
Output bytes 0 
Parameter bytes 3 
Diagnostic bytes 0 
Housing  
Material PPE / PA 6.6 
Mounting Profile rail 35 mm 
Mechanical data  
Dimensions (WxHxD) 50.8 x 76 x 80 mm 
Weight 150 g 
Environmental conditions  
Operating temperature 0 °C to 60 °C 
Storage temperature -25 °C to 70 °C 
Certifications  
UL508 certification yes 
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Order no. 215-2BT13 
Type CPU 215NET 
Technical data power supply  
Power supply (rated value) DC 24 V 
Power supply (permitted range) DC 20.4...28.8 V 
Reverse polarity protection  
Current consumption (no-load operation) 140 mA 
Current consumption (rated value) 1.5 A 
Inrush current 65 A 
I²t 0.75 A²s 
Max. current drain at backplane bus 3 A 
Power loss 6 W 
Load and working memory  
Load memory, integrated 192 KB 
Load memory, maximum 192 KB 
Work memory, integrated 128 KB 
Work memory, maximal 128 KB 
Memory divided in 50% program / 50% data - 
Memory card slot MMC-Card with max. 512 MB 
Hardware configuration  
Racks, max. 4  
Modules per rack, max. total max. 32 
Number of integrated DP master - 
Number of DP master via CP 8  
Operable function modules 32  
Operable communication modules PtP 32  
Operable communication modules LAN - 
Command processing times  
Bit instructions, min. 0.18 µs 
Word instruction, min. 0.78 µs 
Double integer arithmetic, min. 1.8 µs 
Floating-point arithmetic, min. 40 µs 
Timers/Counters and their retentive 
characteristics 

 

Number of S7 counters 256  
S7 counter remanence adjustable 0 up to 64 
S7 counter remanence adjustable C0 .. C7 
Number of S7 times 256  
S7 times remanence adjustable 0 up to 128 
S7 times remanence adjustable not retentive 
Data range and retentive characteristic  
Number of flags 8192 Bit 
Bit memories retentive characteristic adjustable adjustable 0 up to 256 
Bit memories retentive characteristic preset MB0 .. MB15 
Number of data blocks 2047  
Max. data blocks size 16 KB 
Number range DBs 1 ... 2047 
Max. local data size per execution level 1024 Byte 
Max. local data size per block 1024 Byte 
Blocks  
Number of OBs 14  
Maximum OB size 16 KB 
Total number DBs, FBs, FCs - 
Number of FBs 1024  
Maximum FB size 16 KB 
Number range FBs 0 ... 1023 
Number of FCs 1024  
Maximum FC size 16 KB 
Number range FCs 0 ... 1023 
Maximum nesting depth per priority class 8  
Maximum nesting depth additional within an error OB 1  

215-2BT13    
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Order no. 215-2BT13 
Time  
Real-time clock buffered  
Clock buffered period (min.) 30 d 
Type of buffering  Vanadium Rechargeable 

Lithium Batterie 
Load time for 50% buffering period 20 h 
Load time for 100% buffering period 48 h 
Accuracy (max. deviation per day) 10 s 
Number of operating hours counter 8  
Clock synchronization - 
Synchronization via MPI - 
Synchronization via Ethernet (NTP) - 
Address areas (I/O)  
Input I/O address area 1024 Byte 
Output I/O address area 1024 Byte 
Process image adjustable - 
Input process image preset 128 Byte 
Output process image preset 128 Byte 
Input process image maximal 128 Byte 
Output process image maximal 128 Byte 
Digital inputs 8192  
Digital outputs 8192  
Digital inputs central 512  
Digital outputs central 512  
Integrated digital inputs - 
Integrated digital outputs - 
Analog inputs 512  
Analog outputs 512  
Analog inputs, central 128  
Analog outputs, central 128  
Integrated analog inputs - 
Integrated analog outputs - 
Communication functions  
PG/OP channel  
Global data communication  
Number of GD circuits, max. 4  
Size of GD packets, max. 22 Byte 
S7 basic communication  
S7 basic communication, user data per job 76 Byte 
S7 communication  
S7 communication as server  
S7 communication as client - 
S7 communication, user data per job 160 Byte 
Number of connections, max. 16  
Functionality Sub-D interfaces  
Type MP²I 
Type of interface RS485 
Connector Sub-D, 9-pin, female 
Electrically isolated - 
MPI  
MP²I (MPI/RS232)  
Point-to-point interface - 
Functionality MPI  
Number of connections, max. 16  
PG/OP channel  
Routing - 
Global data communication  
S7 basic communication  
S7 communication  
S7 communication as server  
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Order no. 215-2BT13 
S7 communication as client - 
Transmission speed, min. 19.2 kbit/s 
Transmission speed, max. 187.5 kbit/s 
Functionality RJ45 interfaces  
Type TP 
Type of interface Ethernet 10/100 MBit 
Connector RJ45 
Electrically isolated  
PG/OP channel  
Number of connections, max. 8  
Productive connections  
Ethernet communication CP  
Number of productive connections, max. 16  
Number of productive connections by Siemens 
NetPro, max. 

16  

S7 connections - 
User data per S7 connection, max. - 
TCP-connections SEND, RECEIVE, FETCH 

PASSIV, WRITE PASSIV, 
Connection of active and 
passive data handling 

User data per TCP connection, max. 64 KB 
ISO-connections SEND and RECEIVE 
User data per ISO connection, max. 8 KB 
ISO on TCP connections (RFC 1006) SEND, RECEIVE, FETCH 

PASSIV, WRITE PASSIV, 
Connection of active and 
passive data handling 

User data per ISO on TCP connection, max. 32 KB 
UDP-connections SEND and RECEIVE 
User data per UDP connection, max. 2 KB 
UDP-multicast-connections SEND and RECEIVE 

(max. 16 Multicast groups) 
UDP-broadcast-connections SEND 
Datasizes  
Input bytes 0 
Output bytes 0 
Parameter bytes 3 
Diagnostic bytes 0 
Housing  
Material PPE / PA 6.6 
Mounting Profile rail 35 mm 
Mechanical data  
Dimensions (WxHxD) 50.8 x 76 x 80 mm 
Weight 150 g 
Environmental conditions  
Operating temperature 0 °C to 60 °C 
Storage temperature -25 °C to 70 °C 
Certifications  
UL508 certification yes 
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Chapter 3  Deployment CPU 21x-2BT13 
 

This chapter describes the deployment of the CPU in the System 200V. 
The description refers directly to the CPU and to the deployment in 
connection with peripheral modules, mounted on a profile rail together with 
the CPU at the backplane bus. 
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Assembly 
 

Note! 
Information about assembly and cabling may be found at chapter "Basics 
and Assembly". 
 

Start-up behavior 
 

When the CPU is delivered it has been reset. After the power supply has 
been switched on, the CPU changes to the operating mode the operating 
mode lever shows. After a STOP→RUN transition the CPU switches to 
RUN without program. 
 
Note! 
Due to a long storage of the CPU, the battery may be discharged 
excessively. Please connect the CPU at least for 24 hours to the power 
supply, to achieve the full buffer capacity. 
 
The CPU switches to RUN with the program stored in the battery buffered 
RAM. 
 
 
The accumulator/battery is automatically loaded via the integrated power 
supply and guarantees a buffer for max. 30 days. If this time is exceeded, 
the battery may be totally discharged. This means that the battery buffered 
RAM is deleted. 
In this state, the CPU executes an overall reset because with an empty 
battery the RAM content is undefined. If a MMC with a S7PROG.WLD is 
plugged, program code and data blocks are transferred from the MMC into 
the work memory of the CPU. 
If there is no MMC, the project from the internal Flash is loaded. 
Depending on the position of the operating mode switch, the CPU remains 
in STOP respectively switches to RUN. Due to the battery error the CPU 
can only boot if there was an OB81 configured. Otherwise a manual restart 
(STOP/RUN) respectively PG command is necessary. 
On a start-up with an empty battery the SF LED is on and thus points to an 
entry in the diagnostic buffer. Information about the Event-IDs can be found 
at "VIPA specific diagnostic entries". 
 

Attention! 
After a power reset and with an empty battery the CPU starts with a BAT 
error and executes an overall reset.  

     

Turn on power 
supply 

     

Boot procedure with 
valid data in the 
CPU 

Boot procedure 
with empty battery 
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Addressing 
 

To provide specific addressing of the installed peripheral modules, certain 
addresses must be allocated in the CPU. 
The CPU contains a peripheral area (addresses 0 ... 1023) and a process 
image of the inputs and the outputs (for both each address 0 ... 127). 
When the CPU is initialized it automatically assigns peripheral addresses to 
the digital input/output modules starting from 0.  
If there is no hardware projecting, analog modules are allocated to even 
addresses starting from address 128.  
 

The signaling states of the lower addresses (0 ... 127) are additionally 
saved in a special memory area called the process image.  
The process image is divided into two parts: 
• process image of the inputs (PII) 
• process image of the outputs (PIQ) 
 

Peripheral area
0
.
.
.

127

128
.
.
.

1023

Process image
0
.
.
.

127

0
.
.
.

127

Inputs
PII

Outputs
PIQ

Digital modules

Analog modules

 
 
The process image is updated automatically when a cycle has been 
completed.  
 

You may access the modules by means of read or write operations on the 
peripheral bytes or on the process image. 
 

Note! 
Please remember that you may access different modules by means of read 
and write operations on the same address.  
The addressing ranges of digital and analog modules are different when 
they are addressed automatically. 
Digital modules:   0 ... 127 
Analog modules: 128 ... 1023 

Automatic 
addressing 

Signaling states in 
the process image 

Read/write access 
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The following figure illustrates the automatic allocation of addresses: 
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You may change the allocated addresses at any time by means of the 
Siemens SIMATIC manager. In this way you may also change the addres-
ses of analog modules to the range covered by the process image  
(0 ... 127) and address digital modules above 127. 
The following pages describe the required preparations and the procedure 
for this type of configuration. 
 
 

Example for auto-
matic address 
allocation 

Modifying allocated 
addresses by 
configuration 
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Hints for the deployment of the MPI interface 
 

The MP2I jack combines 2 interfaces in 1: 
• MP interface 
• RS232 interface 
Please regard that the RS232 functionality is only available by using the 
Green Cable from VIPA.   
 

The MP interface provides the data transfer between CPUs and PCs. In a 
bus communication you may transfer programs and data between the 
CPUs interconnected via MPI. 
Connecting a common MPI cable, the MPI jack supports the full MPI 
functionality. 
 
 

Important notes for the deployment of MPI cables! 
Deploying MPI cables at the CPUs from VIPA, you have to make sure that 
Pin 1 is not connected. This may cause transfer problems and in some 
cases damage the CPU! 
Especially PROFIBUS cables from Siemens, like e.g. the  
6XV1 830-1CH30, must not be deployed at MP2I jack. 
For damages caused by nonobservance of these notes and at improper 
deployment, VIPA does not take liability! 
 

 
For the serial data transfer from your PC, you normally need a MPI 
transducer. Fortunately you may also use the "Green Cable" from VIPA. 
You can order this under the order no. VIPA 950-0KB00. 
 

 

The "Green Cable" supports a serial point-to-point connection for data 
transfer via the MP2I jack exclusively for VIPA CPUs. 

 
 

What is MP2I? 

Deployment as  
MP interface 

 

Deployment as 
RS232 interface only 
via "Green Cable" 
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Hardware configuration - CPU 
 

For the project engineering of the CPU 21x and the other System 200V 
modules connected to the same VIPA bus, the hardware configurator from 
Siemens is to be used. 
To address the directly plugged peripheral modules, you have to assign a 
special address in the CPU to every module.  
The address allocation and the parameterization of the modules takes 
place in the Siemens SIMATIC manager as a virtual PROFIBUS system. 
For the PROFIBUS interface is standardized software sided, the 
functionality is guaranteed by including a GSD-file into the Siemens  
SIMATIC manager. 
Transfer your project into the CPU via the MPI interface. 
 

 

The following conditions must be fulfilled for project engineering: 
• The Siemens SIMATIC manager is installed at PC respectively PU 
• The GSD files have been included in Siemens hardware configurator 
• Serial connection to the CPU (e.g. MPI-Adapter) 
 

Note! 
The configuration of the CPU requires a thorough knowledge of the 
Siemens SIMATIC manager and the hardware configurator! 
 

• Go to www.vipa.com > Service > Download > PROFIBUS GSD files and 
download the file System_100V_-_200V_Vxxx.zip. 

• Extract the file to your work directory. The vipa_21x.gsd (German) 
respectively vipa_21x.gse (English) can be found at the directory 
CPU21x. 

• Start the Siemens hardware configurator and close every project. 
• Go to Options > Install new GSD file 
• Navigate to the directory CPU21x and choose the corresponding file 

vipa_21x.gsd (German) or vipa_21x.gse (English) 
Now the modules of the VIPA System 200V are integrated in the hardware 
catalog at PROFIBUS-DP \ Additional field devices \ I/O \ 
VIPA_System_200V. 
 
 

Overview 

Requirements 

     

Including the  
GSD-file 
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To be compatible with the Siemens SIMATIC manager the following steps 
should be executed: 
 

 

Module
CPU 21x-2BT13

Slot
0
1
...

PB-
Addr.:1

PB-
Addr.:2

(1) VIPA_CPU
CPU 21x

CPU 214

PW

S F

FC

MC

R

S

RN

ST

MR

MMC

2

Module

CPU 315-2DP 
DP

Slot
1
2
X2
3

PROFIBUS (1): DP master system (1)

 

• Start the hardware configurator from 
Siemens with a new project. 

• Insert a profile rail from the hardware 
catalog. 

• Place at slot 2 the following CPU from 
Siemens:  
CPU 315-2DP (315-2AF03 0AB00 V1.2)

• For the System 200V create a new   
PROFIBUS subnet. 

• Attach the slave system 
"VIPA_CPU21x" to the subnet with 
PROFIBUS-Address 1.  
After installing the vipa_21x.gsd the 
slave system may be found at the 
hardware catalog at PROFIBUS DP > 
Additional field devices > IO > 
VIPA_System_200V. 

• Place always at the 1. slot the 
corresponding CPU 21x-2BT13, by 
taking it from the hardware catalog. 

 
 
 

Proceeding 
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Hardware configuration - I/O modules 
 

After the hardware configuration of the CPU place the System 200V 
modules in the plugged sequence. 
In order to address the installed peripheral modules individually, specific 
addresses in the CPU have to be assigned to them. 
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3
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For parameterization double-click during the project engineering at the slot 
overview on the module you want to parameterize. In the appearing dialog 
window you may set the wanted parameters. 
 
By using the SFCs 55, 56 and 57 you may alter and transfer parameters for 
wanted modules during runtime. 
For this you have to store the module specific parameters in so called 
"record sets". 
More detailed information about the structure of the record sets is to find in 
the according module description. 
 
 
 

Hardware 
configuration of 
the modules  

Parameterization  

Parameterization 
during runtime 
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Hardware configuration - Ethernet PG/OP channel 
 

The CPU has an integrated Ethernet PG/OP channel. This channel allows 
you to program and remote control your CPU. 
With the first start-up respectively after an overall reset the Ethernet PG/OP 
channel does not have any IP address. 
For online access to the CPU via Ethernet PG/OP channel valid IP address 
parameters have to be assigned to this by means of the Siemens SIMATIC 
manager. This is called "initialization". 
 

• Install your System 200V with your CPU.  
• Wire the system by connecting cables for voltage supply and signals. 
• Connect the Ethernet jack of the Ethernet PG/OP channel to Ethernet 
• Switch on the power supply.   

→ After a short boot time the CP is ready for communication.  
He possibly has no IP address data and requires an initialization. 

 

The initialization via PLC functions takes place with the following 
proceeding: 
• Determine the current Ethernet (MAC) address of your Ethernet PG/OP 

channel. This always may be found at a sticker on the left side of the 
CPU. 

 

 
 

Overview 

Assembly and 
commissioning 

"Initialization" via 
PLC functions 
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You get valid IP address parameters from your system administrator. The  
assignment of the IP address data happens online in the Siemens SIMATIC 
manager starting with version V 5.3 & SP3 with the following proceeding: 
• Start the Siemens SIMATIC manager and set via Options > Set PG/PC 

interface the access path to "TCP/IP -> Network card .... ". 
• Open with PLC > Edit Ethernet Node the dialog window with the same 

name. 
• To get the stations and their MAC address, use the [Browse] button or 

type in the MAC Address. The Mac address may be found at the 1. label 
beneath the front flap of the CPU. 

• Choose if necessary the known MAC address of the list of found 
stations.  

• Either type in the IP configuration like IP address, subnet mask and 
gateway. Or your station is automatically provided with IP parameters by 
means of a DHCP server. Depending of the chosen option the DHCP 
server is to be supplied with MAC address, equipment name or client ID. 
The client ID is a numerical order of max. 63 characters. The following 
characters are allowed: "hyphen", 0-9, a-z, A-Z 

• Confirm with [Assign IP configuration]. 
 

Note! 
Direct after the assignment the Ethernet PG/OP channel may be reached 
online by these address data. 
The value remains as long as it is reassigned, it is overwritten by a 
hardware configuration or an factory reset is executed. 
 

• Open the Siemens hardware configurator and configure in deputy of 
your VIPA CPU the Siemens CPU 315-2DP with the order no. 6ES7 
315-2AF03-0AB0 V1.2. which is to be found at SIMATIC 300 \ CPU 300 
\ CPU 315-2 DP \ 6ES7 315-2AF03-0AB0. If needed, parameterize the 
CPU 315-2DP. 

• Configure in deputy of your CP the CP 343-1 (343-1EX11) from 
Siemens at slot 4, to be found at SIMATIC 300 / CP 300 / Industrial 
Ethernet / CP 343-1. 

• Open the property window via double-click on the CP 343-1EX11 and 
enter for the CP at "Properties" the IP address data, which you have 
assigned before.  

• Transfer your project. 
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project 
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Setting CPU parameters 
 

Since the CPU from VIPA is to be configured as Siemens CPU 315-2DP 
(315-2AF03 0AB00 V1.2) in the Siemens hardware configurator, the 
parameters of the VIPA CPU may be set with "Object properties" of the 
CPU 315-2DP during hardware configuration. 
Via a double-click on the CPU 315-2DP the parameter window of the CPU 
may be accessed. 
Using the registers you get access to every standard parameter of the 
CPU. 
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The CPU does not evaluate each parameter, which may be set at the 
hardware configuration.  
The following parameters are supported by the CPU at this time: 
 
 
 
The short description of the Siemens CPU 315-2AF03 is CPU 315-2DP. 
 
Order number and firmware are identical to the details in the "hardware 
catalog" window. 
 
The Name field provides the short description of the CPU. If you change 
the name the new name appears in the Siemens SIMATIC manager. 
  
In this field information about the module may be entered. 
 
 
 
If the checkbox for "Startup when expected/actual configuration differ" is 
deselected and at least one module is not located at its configured slot or if 
another type of module is inserted there instead, then the CPU does not 
switch to RUN mode and remains in STOP mode. 
If the checkbox for "Startup when expected/actual configuration differ" is 
selected, then the CPU starts even if there are modules not located in their 
configured slots of if another type of module is inserted there instead, such 
as during an initial system start-up. 

Parameterization 
via Siemens  
CPU 315-2AF03 

Supported 
parameters 

General 

Short description 

Order No. / 
Firmware 

Name 

Comment 

Startup 

Startup when 
expected/actual 
configuration differs 
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This operation specifies the maximum time for the ready message of every 
configured module after PowerON. Here connected PROFIBUS DP slaves 
are also considered until they are parameterized. If the modules do not 
send a ready message to the CPU by the time the monitoring time has 
expired, the actual configuration becomes unequal to the preset 
configuration. 
 
The maximum time for the transfer of parameters to parameterizable 
modules. If not every module has been assigned parameters by the time 
this monitoring time has expired; the actual configuration becomes unequal 
to the preset configuration. 
 

 
 
This parameter is not relevant. 
 
 
Here the scan cycle monitoring time in milliseconds may be set. If the scan 
cycle time exceeds the scan cycle monitoring time, the CPU enters the 
STOP mode. Possible reasons for exceeding the time are: 
• Communication processes 
• a series of interrupt events 
• an error in the CPU program 
 
This parameter is not relevant. 
 
 
Using this parameter you can control the duration of communication 
processes, which always extend the scan cycle time so it does not exceed 
a specified length. 
If the cycle load from communication is set to 50%, the scan cycle time of 
OB 1 can be doubled. At the same time, the scan cycle time of OB 1 is still 
being influenced by asynchronous events (e.g. hardware interrupts) as well. 
 
The preset reaction of the CPU may be changed to an I/O access error that 
occurs during the update of the process image by the system. 
The VIPA CPU is preset such that OB 85 is not called if an I/O access error 
occurs and no entry is made in the diagnostic buffer either. 
 
Activate the check box if you want to use clock memory and enter the 
number of the memory byte. 
 

Note! 
The selected memory byte cannot be used for temporary data storage. 
 
 

Monitoring time for 
ready message by 
modules [100ms] 

Monitoring time for 
transfer of 
parameters to 
modules [100ms] 

Cycle/Clock 
memory 
Update OB1 
process image 
cyclically 
 
Scan cycle 
monitoring time 

Minimum scan  
cycle time 

Scan cycle load 
from Communi-
cation 

OB85 call up at I/O 
access error 

Clock memory 
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Enter the number of retentive memory bytes from memory byte 0 onwards. 
 
 
Enter the number of retentive S7 timers from T0 onwards. Each S7 timer 
occupies 2bytes. 
 
Enter the number of retentive S7 counter from C0 onwards. 
 
 
These parameters are not relevant. 
 

 
 
Here the priorities are displayed, according to which the hardware interrupt 
OBs are processed (hardware interrupt, time-delay interrupt, async. error 
interrupts).  
  
 
 
 
Here the priorities may be specified according to which the time-of-day 
interrupt is processed. 
With priority "0" the corresponding OB is deactivated. 
 
Activate the check box of the time-of-day interrupt OBs if these are to be 
automatically started on complete restart. 
 
Select how often the interrupts are to be triggered. Intervals ranging from 
every minute to yearly are available. The intervals apply to the settings 
made for start date and time. 
 
Enter date and time of the first execution of the time-of-day interrupt. 
 
This parameter is not supported. 
 

 
 
Here the priorities may be specified according to which the corresponding 
cyclic interrupt is processed. With priority "0" the corresponding interrupt is 
deactivated. 
 

Retentive Memory 

Number of Memory 
Bytes from MB0 
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Priority 
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Enter the time intervals in ms, in which the watchdog interrupt OBs should 
be processed. The start time for the clock is when the operating mode 
switch is moved from STOP to RUN. 
 
Enter the delay time in ms for current execution for the watch dog interrupt. 
This should be performed if several watchdog interrupts are enabled. 
Phase offset allows to distribute processing time for watchdog interrupts 
across the cycle. 
 
This parameter is not supported. 
 
  

 
 
Here 1 of 3 protection levels may be set to protect the CPU from 
unauthorized access. 
Protection level 1 (default setting): 
• No password adjustable, no restrictions 
Protection level 2 with password: 
• Authorized users: read and write access 
• Unauthorized user: read access only 
Protection level 3: 
• Authorized users: read and write access 
• Unauthorized user: no read and write access 
 
 

Execution 

Phase offset 

Process image 
partition 

Protection 

Level of protection 
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Project transfer 
 

There are the following possibilities for project transfer into the CPU: 
• Transfer via MPI 
• Transfer via Ethernet 
• Transfer via MMC when using a MMC programmer 
 
 

The structure of a MPI net is electrically identical with the structure of a 
PROFIBUS net. This means the same rules are valid and you use the 
same components for the build-up. The single participants are connected 
with each other via bus interface plugs and PROFIBUS cables. Per default 
the MPI net runs with 187.5kbaud. VIPA CPUs are delivered with MPI 
address 2. 
 

The MPI programming cables are available at VIPA in different variants. 
The cables provide a RS232 res. USB plug for the PC and a bus enabled 
RS485 plug for the CPU. 
Due to the RS485 connection you may plug the MPI programming cables 
directly to an already plugged plug on the RS485 jack. Every bus 
participant identifies itself at the bus with an unique address, in the course 
of the address 0 is reserved for programming devices. 
 

A cable has to be terminated with its surge impedance. For this you switch 
on the terminating resistor at the first and the last participant of a network or 
a segment. 
Please make sure that the participants with the activated terminating 
resistors are always power supplied. Otherwise it may cause interferences 
on the bus. 
Transfer with MPI programming cable (MPI communication) 
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Transfer via Green Cable (serial communication) 
Via exclusively direct plugging of the Green Cable to a MP2I jack you may 
establish a serial connection between PC and CPU. Set the PC-COM port 
and the transfer rate 38400Baud at Local port. The settings of the register 
MPI are ignored at employment of the Green Cable. 

Green Cable

STEP7
from Siemens

MPI net
 

Overview 

Transfer via MPI 

MPI programming 
cable 

Terminating resistor 
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Hints for configuring a MPI interface are to find in the documentation of 
your programming software.  
The "Green Cable" has the order number VIPA 950-0KB00. 
 

Attention! 
Please regard, that you may use the "Green Cable" exclusively at VIPA 
CPUs with MP2I-interface! 
Please regard the hints for deploying the Green Cable and the MP2I jack! 
 

• Connect your PC to the MPI jack of your CPU via a MPI programming 
cable.  

• Load your project in the SIMATIC manager from Siemens. 
• Choose in the menu Options > Set PG/PC interface 
• Select in the according list the "PC Adapter (MPI)"; if appropriate you 

have to add it first, then click on [Properties]. 
• Set in the register MPI the transfer parameters of your MPI net and type 

a valid address. 
• Switch to the register Local connection 
• Set the COM port of the PC and the transfer rate 38400Baud for the MPI 

programming cable from VIPA.  
• Via PLC > Load to module you may transfer your project via MPI to the 

CPU and save it on a MMC via PLC > Copy RAM to ROM if one is 
plugged. 

 

Note! 
Please make sure to adjust the transfer rate to 38400Baud when using the 
"Green Cable" from VIPA.  
 

Configure MPI 

 

Approach transfer 
via MPI interface 
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The Green Cable is a green connection cable, manufactured exclusively for 
the deployment at VIPA System components. 
The Green Cable is a programming and download cable for VIPA CPUs 
MP2I jack and VIPA field bus masters. The Green Cable from VIPA is 
available under the order no. VIPA 950-0KB00. 
 
The Green Cable allows you to: 

 

• transfer projects serial  
Avoiding high hardware needs (MPI transducer, etc.) you may realize a 
serial point-to-point connection via the Green Cable and the MP2I jack. 
This allows you to connect components to your VIPA-CPU that are able 
to communicate serial via a MPI adapter like e.g. a visualization system.

• execute firmware updates of the CPUs and field bus masters 
Via the Green Cable and an upload application you may update the 
firmware of all recent VIPA CPUs with MP2I jack and certain field bus 
masters (see Note). 

 
 

Important notes for the deployment of the Green Cable 
Nonobservance of the following notes may cause damages on system 
components. 
For damages caused by nonobservance of the following notes and at 
improper deployment, VIPA does not take liability! 
 

Note to the application area 
The Green Cable may exclusively deployed directly at the concerning jacks 
of the VIPA components (in between plugs are not permitted). E.g. a MPI 
cable has to be disconnected if you want to connect a Green Cable. 
At this time, the following components support Green Cable: 
VIPA CPUs with MP2I jack and field bus masters from VIPA. 
 

Note to the lengthening 
The lengthening of the Green Cable with another Green Cable res. The 
combination with further MPI cables is not permitted and causes damages 
of the connected components! 
The Green Cable may only be lengthened with a 1:1 cable  
(all 9 pins are connected 1:1). 
 

Hints for the 
Green Cable  
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For transfer via Ethernet the CPU has the following interface: 
• Ethernet PG/OP channel 
 

So that you may access the Ethernet PG/OP channel you have to assign IP 
address parameters by means of the "initialization". More may be found at 
"Hardware configuration - Ethernet PG/OP channel". 
 

• For the transfer, connect, if not already done, the appropriate Ethernet 
port to your Ethernet. 

• Open your project with the Siemens SIMATIC manager. 
• Set via Options > Set PG/PC Interface the access path to "TCP/IP -> 

Network card .... ". 
• Click to PLC > Download → the dialog "Select target module" is opened. 

Select your target module and enter the IP address parameters of the 
Ethernet PG/OP channel for connection. Provided that no new hardware 
configuration is transferred to the CPU, the entered Ethernet connection 
is permanently stored in the project as transfer channel. 

• With [OK] the transfer is started. 
 

Note! 
System dependent you get a message that the projected system differs 
from target system. This message may be accepted by [OK]. 
→ your project is transferred and may be executed in the CPU after 
transfer. 
 
 

Transfer via 
Ethernet 

Initialization 

Transfer 
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The MMC (Memory Card) serves as external transfer and storage medium. 
There may be stored several projects and sub-directories on a MMC 
storage module. Please regard that your current project is stored in the root 
directory and has one of the following file names: 
• S7PROG.WLD 
• S7PROGF.WLD 
• AUTOLOAD.WLD 
With File > Memory Card File > New in the Siemens SIMATIC manager a  
new wld file may be created. After the creation copy the blocks from the 
project blocks folder and the System data into the wld file. 
 
The transfer of the application program from the MMC into the CPU takes 
place depending on the file name after an overall reset or PowerON. 
• S7PROG.WLD is read from the MMC after overall reset and transferred 

into the battery buffered RAM. 
• S7PROGF.WLD is read from the MMC after overall reset and 

transferred into the battery buffered RAM and additionally into the Flash 
memory. An access to the Flash memory only takes place at empty 
battery of the buffer and when no MMC with user program is plugged-in. 

• AUTOLOAD.WLD is read after PowerON from the MMC and transferred 
into the battery-buffered RAM . 

During the transfer the "MC" LED blinks. Please regard that your user 
memory serves for enough space, otherwise your user program is not 
completely loaded and the SF LED gets on.  Execute a compression before 
the transfer, for this does not happen automatically. 
 
When the MMC has been installed, the write command stores the content 
of the battery buffered RAM as S7PROG.WLD on the MMC and in the 
internal Flash memory.  
The write command is controlled by means of the block area of the 
Siemens SIMATIC manager PLC > Copy RAM to ROM. During the write 
process the "MC"-LED of the CPU is blinking. When the LED expires the 
write process is finished. 
If this project is to be loaded automatically from the MMC with PowerON, 
you have to rename this on the MMC to AUTOLOAD.WLD. 
 
After a MMC access, an ID is written into the diagnostic buffer of the CPU. 
To monitor the diagnosis entries, you select PLC > Module Information in 
the Siemens SIMATIC manager. Via the register "Diagnostic Buffer" you 
reach the diagnosis window.  
Information about the Event-IDs can be found at "VIPA specific diagnostic 
entries". 

Transfer via 
MMC 

Transfer  
MMC →→→→ CPU 

Transfer  
CPU →→→→ MMC 

Transfer control 
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Operating modes 
 

The CPU can be in one of 3 operating modes: 
• Operating mode STOP 
• Operating mode START-UP 
• Operating mode RUN 
 
Certain conditions in the operating modes START-UP and RUN require a 
specific reaction from the system program. In this case the application 
interface is often provided by a call to an organization block that was 
included specifically for this event. 
 

• The application program is not processed. 
• If there has been a processing before, the values of counters, timers, 

flags and the process image are retained during the transition to the 
STOP mode. 

• Outputs are inhibited, i.e. all digital outputs are disabled. 
• RUN-LED (R)  off 
• STOP-LED (S) on 
 

• During the transition from STOP to RUN the system calls the start-up 
organization block OB 100. The processing time for this OB is not 
monitored. The start-up OB may issue calls to other blocks. 

• All digital outputs are disabled during the start-up, i.e. outputs are 
inhibited. 

• RUN-LED blinks as soon as the OB 100 is operated and for at least 
   3s, even if the start-up time is shorter or the CPU gets to 
   STOP due to an error. This indicates the start-up. 

• STOP-LED off 
When the CPU has completed the start-up OB, it assumes the operating 
mode RUN. 
 

• The application program in OB 1 is processed in a cycle. Under the 
control of alarms other program sections can be included in the cycle. 

• All timers and counters being started by the program are active and the 
process image is updated with every cycle. 

• The BASP-signal (outputs inhibited) is deactivated, i.e. all digital outputs 
are enabled. 

• RUN-LED on 
• STOP-LED off 

Overview 

Operating mode 
STOP 

Operating mode 
START-UP 

Operating mode 
RUN 
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The CPUs include security mechanisms like a watchdog (100ms) and a 
parameterizable cycle time surveillance (parameterizable min. 1ms) that 
stop res. execute a RESET at the CPU in case of an error and set it into a 
defined STOP state. 
The VIPA CPUs are developed function secure and have the following 
system properties: 
 

Event concerns Effect 
RUN → STOP general BASP (Befehls-Ausgabe-Sperre, i.e. command 

output lock) is set. 
 central digital outputs The outputs are disabled. 
 central analog outputs The Outputs are disabled. 

- Voltage outputs issue 0V 
- Current outputs 0...20mA issue 0mA 
- Current outputs 4...20mA issue 4mA  
If configured also substitute values may be  
issued. 

 decentral outputs Same behavior as the central digital/analog 
outputs. 

 decentral inputs The inputs are cyclically be read by the decentra-
lized station and the recent values are put at 
disposal. 

STOP → RUN 
res. PowerON 

general First the PII is deleted, then OB 100 is called. After 
the execution of the OB, the BASP is reset and the 
cycle starts with:   
Delete PIO → Read PII → OB 1. 

 central analog outputs The behavior of the outputs at restart can be 
preset.  

 decentral inputs The inputs are cyclically be read by the decentra-
lized station and the recent values are put at 
disposal. 

RUN general The program execution happens cyclically and can 
therefore be foreseen:  
Read PII → OB 1 → Write PIO. 

 
PII = Process image inputs 
PIO = Process image outputs 

 
 

Function security 
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Overall reset 
 

During the overall reset the entire user memory is erased. Data located in 
the memory card is not affected. 
You have 2 options to initiate an overall reset: 
• initiate the overall reset by means of the function selector switch 
• initiate the overall reset by means of the configuration software e.g. 

Siemens SIMATIC manager 
 
Note! 
You should always issue an overall reset to your CPU before loading an 
application program into your CPU to ensure that all blocks have been 
cleared from the CPU. 
 

Condition 
The operating mode of the CPU is STOP. Place the function selector on the 
CPU in position "ST" → the S-LED is on. 
 

Overall reset 
• Place the function selector in the position MR and hold it in this position 

for app. 3 seconds. → The S-LED changes from blinking to permanently 
on. 

• Place the function selector in the position ST and switch it to MR and 
quickly back to ST within a period of less than 3 seconds.  
→ The S-LED blinks (overall reset procedure). 

• The overall reset has been completed when the S-LED is on 
permanently. → The S-LED is on. 

 
The following figure illustrates the above procedure: 
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Overview 
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If there is a project S7PROG.WLD on the MMC, the CPU attempts to 
reload this project from MMC → the MC LED is on. 
When the reload has been completed the LED is extinguished. The 
operating mode of the CPU will be STOP or RUN, depending on the 
position of the function selector. 
 

Condition 
The operating mode of the CPU must be STOP.  
You may place the CPU in STOP mode by the menu command 
PLC > Operating mode. 
 
Overall reset 
You may request the overall reset by means of the menu command PLC > 
Clean/Reset. 
In the dialog window you may place your CPU in STOP mode and start the 
overall reset if this has not been done as yet. 
The S-LED blinks during the overall reset procedure. 
When the S-LED is on permanently the overall reset procedure has been 
completed. 
 

At this point the CPU attempts to reload the parameters and the program 
from the memory card. → The MC LED is on. 
When the reload has been completed, the LED expires. The operating 
mode of the CPU will be STOP or RUN, depending on the position of the 
function selector. 
 

A Factory reset deletes the internal RAM of the CPU completely and sets it 
back to the delivery state. 
Please regard that the MPI address is also set back to default 2! 
More information may be found at the part "Factory reset" further below. 
 
 

Automatic reload 

Overall reset by 
means of the 
Siemens SIMATIC 
manager 

Automatic reload 

Reset to factory 
setting 
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Firmware update 
 

There is the opportunity to execute a firmware update for the CPU and its 
components via MMC. For this an accordingly prepared MMC must be in 
the CPU during the startup. 
So a firmware files can be recognized and assigned with startup, a file 
name is reserved for each updateable component (see table below). 
After PowerON and CPU STOP the CPU checks if there is a firmware file 
on the MMC. If this firmware version is different to the existing firmware 
version, this is indicated by blinking of the LEDs and the firmware may be 
installed by an update request. 
 

The latest firmware versions are to be found in the service area at 
www.vipa.com 
 

A label on the rear of the module indicates the firmware version. 
You may display the current firmware version of your CPU via the Siemens 
SIMATIC manager. To display the firmware version, you go online with the 
CPU via your PG or PC and start the Siemens SIMATIC manager.  
Via PLC > Module status, register "General", the current firmware version is 
evaluated and displayed. 
 

 

• Go to www.vipa.com 
• Click on Service > Download > Firmware. 
• Navigate to via System 200V > CPU to your CPU and download 

according to your hardware version the zip file to your PC. 
• Open the zip file and copy the files to your MMC. 
• Rename this accordingly 
 
By means of a reserved file name in the CPU 21x-2BT13 you may transfer 
a firmware per MMC: 
 
Component File name  

order no._release_version.ZIP 
New file name  
at MMC 

CPU Bx000... .bin firmware.bin 
CP  px000018.pkg px000018.pkg 

 

 
 

Overview 

Latest Firmware at 
www.vipa.com 

Find out CPU  
firmware version 

Load firmware and 
transfer it to MMC 
with reserved file 
name 

Reserved file 
names 
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Attention! 
When installing a new firmware you have to be extremely careful. Under 
certain circumstances you may destroy the CPU, for example if the voltage 
supply is interrupted during transfer or if the firmware file is defective. 
In this case, please call the VIPA-Hotline! 
Please regard that the version of the update firmware has to be different 
from the existing firmware otherwise no update is executed. 
 

1. Switch the operating mode switch of your CPU in position ST. Turn off 
the voltage supply. Plug the MMC with the firmware files into the CPU. 
Please take care of the correct plug-in direction of the MMC. Turn on 
the voltage supply. 

2. After a short boot-up time, the alternate blinking of the LEDs SF and FC 
shows that at least a differing firmware file was found on the MMC. 

3. You start the transfer of the firmware as soon as you tip the operating 
mode switch lever downwards to MR within 10s and leave it in ST 
position. 

4. During the update process, the LEDs SF and FC are alternately blinking 
and MC LED is on. This may last several minutes. 

5. The update is successful finished when the LEDs PW, S, SF, FC and 
MC are on. If they are blinking fast, an error occurred. 

6. Turn Power OFF and ON. Now it is checked by the CPU, whether 
further current firmware versions are available at the MMC. If so, again 
the LEDs SF and FC flash after a short start-up period. Continue with 
point 3. 
If the LEDs do not flash, the firmware update is ready.  
Now a factory reset should be executed (see next page). After that the 
CPU is ready for duty. 
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Factory reset 
 

With the following proceeding the internal RAM of the CPU is completely 
deleted and the CPU is reset to delivery state.  
Please note that here also the MPI address is reset to the address 2! 
 
1. Switch the CPU to STOP. 
2. Push the operating mode switch down to position MR for 30s. Here the 

S LED flashes. After a few seconds the stop LED changes to static 
light. Now the S LED changes between static light and flashing. Starting 
here count the static light states of the S LED. 

3. After the 6. static light release the operating mode switch and tip it 
downwards to MR. Now the RUN LED lights up once. This means that 
the RAM was deleted completely. 

4. For the confirmation of the resetting procedure the LEDs PW and S are 
on.  

5. Then you have to switch the power supply off and on. 
 
The proceeding is shown in the following Illustration: 
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Note! 
After the firmware update you always should execute a Factory reset. 
 
 

Proceeding 
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VIPA specific diagnostic entries 
 

You may read the diagnostic buffer of the CPU via the Siemens  SIMATIC 
manager. Besides of the standard entries in the diagnostic buffer, the VIPA 
CPUs support some additional specific entries in form of event-IDs. 
 

To monitor the diagnostic entries you choose the option PLC > Module 
Information in the Siemens SIMATIC manager. Via the register "Diagnostic 
Buffer" you reach the diagnostic window: 
 

Module information

Diagnostic Buffer

Nr.
8
9
10
11
12
13

Time of day
...
...
13:18:11:370
...
...
...

Date
...
...
19.12.2011
...
...
...

Event
...
...
Event-ID: 16# E0CC
...
...
...

Path: Accessible Nodes MPI = 2 Operating mode CPU: RUN

Details:

...

VIPA-ID

... ... ... ...

... ... ... ... ... ...

 
 
The diagnosis is independent from the operating mode of the CPU. You 
may store a max. of 100 diagnostic entries in the CPU. 
The following page shows an overview of the VIPA specific Event-IDs. 
 
 

Entries in the 
diagnostic buffer 

Monitoring the 
diagnostic entries 
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Event-ID Description 
0xE003 Error at access to I/O devices  

Zinfo1: I/O address 
Zinfo2: Slot 

0xE004 Multiple parameterization of a I/O address  
Zinfo1: I/O address 
Zinfo2: Slot 

0xE005 Internal error – Please contact the VIPA-Hotline! 
0xE006 Internal error – Please contact the VIPA-Hotline! 
0xE007 Configured in-/output bytes do not fit into I/O area  
0xE008 Internal error – Please contact the VIPA-Hotline! 
0xE009 Error at access to standard back plane bus 
0xE010 Not defined module group at backplane bus recognized 

Zinfo2: Slot 
Zinfo3: Type ID 

0xE011 Master project engineering at Slave-CPU not possible or wrong slave configuration 
0xE012 Error at parameterization 
0xE013 Error at shift register access to VBUS digital modules 
0xE014 Error at Check_Sys 
0xE015 Error at access to the master 

Zinfo2: Slot of the master (32=page frame master) 
0xE016 Maximum block size at master transfer exceeded  

Zinfo1: I/O address  
Zinfo2: Slot 

0xE017 Error at access to integrated slave 
0xE018 Error at mapping of the master I/O devices 
0xE019 Error at standard back plane bus system recognition 
0xE01A Error at recognition of the operating mode (8 / 9 Bit) 

  
0xE0CC Communication error MPI / Serial 

  
0xE100 MMC access error 
0xE101 MMC error file system 
0xE102 MMC error FAT 
0xE104 MMC error at saving 
0xE200 MMC writing finished (Copy Ram to Rom) 
0xE210 MMC reading finished (reload after overall reset) 
0xE300 Internal Flash writing ready  (Copy RAM to ROM) 
0xE310 Internal Flash reading finished (reload after battery failure) 

 
 

Overview of the 
Event-IDs 
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Using test functions for control and monitoring of variables 
 

For troubleshooting purposes and to display the status of certain variables 
you can access certain test functions via the menu item Debug of the 
Siemens SIMATIC manager. 
The status of the operands and the VKE can be displayed by means of the 
test function Debug > Monitor. 
You can modify and/or display the status of variables by means of the test 
function PLC > Monitor/Modify Variables. 
 

This test function displays the current status and the VKE of the different 
operands while the program is being executed.   
It is also possible to enter corrections to the program. 
 

Note! 
When using the test function “Monitor” the PLC must be in RUN mode! 
 

The processing of the states may be interrupted by means of jump 
commands or by timer and process-related alarms. At the breakpoint the 
CPU stops collecting data for the status display and instead of the required 
data it only provides the PG with data containing the value 0. 
For this reason, jumps or time and process alarms can result in the value 
displayed during program execution remaining at 0 for the items below: 
 
• the result of the logical operation VKE 
• Status / AKKU 1 
• AKKU 2 
• Condition byte 
• absolute memory address SAZ. In this case SAZ is followed by a "?". 
 
The interruption of the processing of statuses does not change the 
execution of the program. It only shows that the data displayed is no longer. 

Overview 

Debug > Monitor 
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This test function returns the condition of a selected operand (inputs, 
outputs, flags, data word, counters or timers) at the end of program-
execution.   
This information is obtained from the process image of the selected 
operands. During the "processing check" or in operating mode STOP the 
periphery is read directly from the inputs. Otherwise only the process image 
of the selected operands is displayed. 
 
Control of outputs 
It is possible to check the wiring and proper operation of output-modules.   
You can set outputs to any desired status with or without a control program. 
The process image is not modified but outputs are no longer inhibited. 
 
Control of variables 
The following variables may be modified: 
I, Q, M, T, C and D. 
The process image of binary and digital operands is modified independently 
of the operating mode of the CPU.    
When the operating mode is RUN the program is executed with the 
modified process variable. When the program continues they may, 
however, be modified again without notification. 
Process variables are controlled asynchronously to the execution sequence 
of the program. 
 
 

PLC > 
Monitor/Modify 
Variables 
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Chapter 4  Deployment Ethernet communication 
 

In this chapter the communication via Ethernet is described. Please regard 
the chapter "Fast introduction" where you will find every information 
compressed required for the project engineering of the CPU 21x-2BT13 
with CP 243. After the fast introduction, the mentioned steps are described 
in detail. 
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Basics - Industrial Ethernet in automation 
 

The flow of information in a company presents a vast spectrum of 
requirements that must be met by the communication systems. Depending 
on the area of business the bus system or LAN must support a different 
number of users, different volumes of data must be transferred and the 
intervals between transfers may vary, etc. 
It is for this reason that different bus systems are employed depending on 
the respective task. These may be subdivided into different classes. The 
following model depicts the relationship between the different bus systems 
and the hierarchical structures of a company: 
 

Operational layer

Management layer

System layer

Prozess layer

Sensor / actuator
layer

Field bus

Sensor / actuator
Bus

H1

Industrial
EthernetPlant

computer
PPS CAD

Plant-oriented
control computer

manufacturing, stock,
production data

PPS CAD

Machine and control
computer

Peripheral systems. machines, CNC, NC,
controllers (PLC), measuring systems

Peripheral components
sensor, actuator, regulator, multiplexer, operating consoles

 
 

Industrial Ethernet is an electrical net based on shielded twisted pair 
cabling or optical net based on optical fibre. 
Ethernet is defined by the international standard IEEE 802.3. The net 
access of Industrial Ethernet corresponds to IEEE 802.3 -  CSMA/CD 
(Carrier Sense Multiple Access/Collision Detection) scheme: every station 
“listens” on the bus cable and receives communication messages that are 
addressed to it.  
Stations will only initiate a transmission when the line is unoccupied. In the 
event that two participants should start transmitting simultaneously, they 
will detect this and stop transmitting to restart after a random delay time 
has expired. 
Using switches there is the possibility for communication without collisions.  
 

Overview 

Industrial Ethernet 
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Basics - ISO/OSI reference model 
 

The ISO/OSI reference model is based on a proposal that was developed 
by the International Standards Organization (ISO). This represents the first 
step towards an international standard for the different protocols. It is 
referred to as the ISO-OSI layer model. OSI is the abbreviation for Open 
System Interconnection, the communication between open systems. The 
ISO/OSI reference model does not represent a network architecture as it 
does not define the services and protocols used by the different layers. The 
model simply specifies the tasks that the different layers must perform. 
All current communication systems are based on the ISO/OSI reference 
model, which is defined by the ISO 7498 standard. The reference model 
structures communication systems into 7 layers that cover different 
communication tasks. In this manner the complexity of the communication 
between different systems is divided amongst different layers to simplify the 
task. 
The following layers have been defined: 
 

Layer Function 
Layer 7 Application Layer 
Layer 6 Presentation Layer 
Layer 5 Session Layer 
Layer 4 Transport Layer 
Layer 3 Network Layer 
Layer 2 Data Link Layer 
Layer 1 Physical Layer 

 

Depending on the complexity and the requirements of the communication 
mechanisms a communication system may use a subset of these layers.  

Overview 
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Layer 1 Bit communication layer (physical layer) 
The bit communication layer (physical layer) is concerned with the transfer 
of data bits via the communication channel. This layer is therefore 
responsible for the mechanical, electrical and the procedural interfaces and 
the physical communication medium located below the bit communication 
layer: 
• Which voltage represents a logical 0 or a 1? 
• The minimum time the voltage is present to be recognized as a bit. 
• The pin assignment of the respective interface. 
 

Layer 2  Security layer (data link layer) 
This layer performs error-checking functions for bit strings transferred 
between two communicating partners. This includes the recognition and 
correction or flagging of communication errors and flow control functions.  
The security layer (data link layer) converts raw communication data into a 
sequence of frames. This is where frame limits are inserted on the 
transmitting side and where the receiving side detects them. These limits 
consist of special bit patterns that are inserted at the beginning and at the 
end of every frame. The security layer often also incorporates flow control 
and error detection functions.  
The data security layer is divided into two sub-levels, the LLC and the MAC 
level. 
The MAC (Media Access Control) is the lower level and controls how 
senders are sharing a single transmit channel. 
The LLC (Logical Link Control) is the upper level that establishes the 
connection for transferring the data frames from one device into the other. 
 
Layer 3 Network layer 
The network layer is an agency layer. 
Business of this layer is to control the exchange of binary data between 
stations that are not directly connected. It is responsible for the logical 
connections of layer 2 communications. Layer 3 supports the identification 
of the single network addresses and the establishing and disconnecting of 
logical communication channels.  
Additionally, layer 3 manages the prior transfer of data and the error 
processing of data packets. IP (Internet Protocol) is based on Layer 3. 
 
Layer 4 Transport layer 
Layer 4 connects the network structures with the structures of the higher 
levels by dividing the messages of higher layers into segments and passes 
them on to the network layer. Hereby, the transport layer converts the 
transport addresses into network addresses. 
Common transport protocols are: TCP, SPX, NWLink and NetBEUI. 
 

Layers 
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Layer 5 Session layer  
The session layer is also called the communication control layer. It relieves 
the communication between service deliverer and the requestor by 
establishing and holding the connection if the transport system has a short 
time fail out. 
At this layer, logical users may communicate via several connections at the 
same time. If the transport system fails, a new connection is established if 
needed.  
Additionally this layer provides methods for control and synchronization 
tasks.  
 
Layer 6 Presentation layer  
This layer manages the presentation of the messages, when different 
network systems are using different representations of data.  
Layer 6 converts the data into a format that is acceptable for both 
communication partners. 
Here compression/decompression and encrypting/decrypting tasks are 
processed. 
This layer is also called interpreter. A typical use of this layer is the terminal 
emulation.  
 
Layer 7 Application layer  
The application layer is the link between the user application and the 
network. The tasks of the application layer include the network services like 
file, print, message, data base and application services as well as the 
according rules.  
This layer is composed from a series of protocols that are permanently 
expanded following the increasing needs of the user. 
 
 

Layers 
continued... 



Chapter 4   Deployment Ethernet communication Manual VIPA System 200V  

4-6  HB97E - CPU - RE_21x-2BT13 - Rev. 14/44 

Basics - Terms 
 

A network res. LAN (Local Area Network) provides a link between different 
stations that enables them to communicate with each other. 
Network stations consist of PCs, IPCs, TCP/IP adapters, etc. 
Network stations are separated by a minimum distance and connected by 
means of a network cable. The combination of network stations and the 
network cable represent a complete segment. 
All the segments of a network form the Ethernet (physics of a network). 
 

In the early days of networking the Triaxial- (yellow cable) or thin Ethernet 
cable (Cheapernet) was used as communication medium. This has been 
superseded by the twisted-pair network cable due to its immunity to 
interference. The CPU has a twisted-pair connector. 
The twisted-pair cable consists of 8 cores that are twisted together in pairs. 
Due to these twists this system is provides an increased level of immunity 
to electrical interference. For linking please use twisted pair cable which at 
least corresponds to the category 5. 
Where the coaxial Ethernet networks are based on a bus topology the 
twisted-pair network is based on a point-to-point scheme. 
The network that may be established by means of this cable has a star 
topology. Every station is connected to the star coupler (hub/switch) by 
means of a separate cable. The hub/switch provides the interface to the 
Ethernet. 
 

The hub is the central element that is required to implement a twisted-pair 
Ethernet network.   
It is the job of the hub to regenerate and to amplify the signals in both 
directions. At the same time it must have the facility to detect and process 
segment wide collisions and to relay this information. The hub is not 
accessible by means of a separate network address since it is not visible to 
the stations on the network. 
A hub has provisions to interface to Ethernet or to another hub res. switch. 
 

A switch also is a central element for realizing Ethernet on Twisted Pair. 
Several stations res. hubs are connected via a switch. Afterwards they are 
able to communicate with each other via the switch without interfering the 
network. An intelligent hardware analyzes the incoming telegrams of every 
port of the switch and passes them collision free on to the destination 
stations of the switch. A switch optimizes the bandwidth in every connected 
segment of a network. Switches enable exclusive connections between the 
segments of a network changing at request. 
 

Network (LAN) 

Twisted Pair 

Hub (repeater) 

Switch 
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Basics - Protocols 
 

Protocols define a set of instructions or standards that enable computer to 
establish communication connections and exchange information as error 
free as possible.  
A commonly established protocol for the standardization of the complete 
computer communication is the so called ISO/OSI layer model, a model 
based upon seven layers with rules for the usage of hardware and software 
(see "Basics - ISO/OSI reference model" above). 
The CP uses the following protocols : 
 
• Communication connections 

- TCP/IP 
- UDP 
- RFC1006 (ISO-ON-TCP) 

The protocols are described in the following: 
 

TCP/IP protocols are available on all major systems. At the bottom end this 
applies to simple PCs, through to the typical mini-computer up to 
mainframes.  
For the wide spread of internet accesses and connections, TCP/IP is often 
used to assemble heterogeneous system pools. 
TCP/IP, standing for Transmission Control Protocol and Internet Protocol, 
collects a various range of protocols and functions. 
TCP and IP are only two of the protocols required for the assembly of a 
complete architecture. The application layer provides programs like "FTP" 
and "Telnet" for the PC.  
The application layer of the Ethernet part of the CPU 21xNET is defined 
with the user application using the standard handling blocks.  
These user applications use the transport layer with the protocols TCP and 
UDP for the data transfer which themselves communicate via the IP 
protocol with the internet layer.  
 

Overview 

TCP/IP 
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The internet protocol covers the network layer (Layer 3) of the ISO/OSI 
layer model.  
The purpose of IP is to send data packages from on PC to another passing 
several other PCs. These data packages are referred to as datagrams. The 
IP doesn't guarantee the correct sequence of the datagrams nor the 
delivery at the receiver.  
For the unambiguous identification between sender and receiver at IPv4 
32Bit addresses (IP addresses) are used that are written as four octets 
(exactly 8Bit), e.g. 172.16.192.11. 
These internet addresses are defined and assigned worldwide from the 
DDN network (Defense Department Network), thus every user may 
communicate with all other TCP/IP users.  
One part of the address specifies the network, the rest serves the 
identification of the participants inside the network. The boarder between 
the network and the host part is variable and depends on the size of the 
network.  
To save IP addresses, so called NAT router are used that have one official 
IP address and cover the network. Then the network can use any IP 
address.  
 

The TCP (Transmission Control Protocol) bases directly on the IP and thus 
covers the transport layer (layer 4) of the OSI layer model. TCP is a 
connection orientated end-to-end protocol and serves the logic connection 
between two partners. 
TCP guarantees the correct sequence and reliability of the data transfer. 
Therefore you need a relatively large protocol overhead that slows down 
the transfer speed.  
Every datagram gets a header of at least 20Byte. This header also contains 
a sequence number identifying the series. This has the consequence that 
the single datagrams may reach the destination on different ways through 
the network. 
Using TCP connections, the whole data length is not transmitted. This 
means that the recipient has to know how many bytes belong to a 
message. To transfer data with variable length you may begin the user data 
with the length information and evaluate this at the counter station.  
 
• Besides of the IP address ports are used for the addressing. A port 

address should be within the range of 2000...65535. Partner and local 
ports may only be identical at one connection.   

• Not depending on the used protocol, the PLC needs the VIPA handling 
blocks AG_SEND (FC5) and AG_RECV (FC6) for data transfer. 

 

IP 

TCP 

Properties 
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The UDP (User Datagram Protocol) is a connection free transport protocol. 
It has been defined in the RFC768 (Request for Comment). Compared to 
TCP, it has much fewer characteristics. 
The addressing happens via port numbers.  
UDP is a fast unsafe protocol for it doesn't care about missing data 
packages nor about their sequence.  
 

The TCP transport service works stream orientated. This means that data 
packages assembled by the user not necessarily have to receive the 
partner in the same packaging. Depending on the data amount, packages 
may though come in the correct sequence but differently packed. This 
causes that the recipient may not recognize the package borders anymore. 
For example you may send 2x 10Byte packages but the counter station 
receives them as 20Byte package. But for most of the applications the 
correct packaging is important.  
Due to this you need another protocol above TCP. This purpose is defined 
in the protocol RFC1006. The protocol definition describes the function of 
an ISO transport interface (ISO 8072) basing upon the transport interface 
TCP (RFC793).  
The basic protocol of RFC1006 is nearly identical to TP0 (Transport 
Protocol, Class 0) in ISO 8073.  
For RFC1006 is run as protocol for TCP, the decoding takes place in the 
data section of the TCP package. 
 

• In contrast to TCP here the receipt of one telegram is confirmed. 
• Instead of ports TSAPs are used for the addressing besides of the IP 

address. The TSAP length may be 1 ... 16Byte. The entry may happen 
in ASCII or Hex format. Foreign and local TSAPs may only be identical 
at 1 connection.   

• Independently of the used protocol the VIPA handling blocks  AG_SEND 
(FC5) and AG_RECEIVE (FC6) are necessary for data transfer.  

• Contrary to TCP different telegram lengths can be received using 
RFC1006. 

 
 

UDP 

ISO-on-TCP 
RFC1006 

Properties 
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Basics - IP address and subnet 
 

Industrial Ethernet exclusively supports IPv4. At IPv4 the IP address is a 
32Bit address that must be unique within the network and consists of 4 
numbers that are separated by a dot.  
Every IP address is a combination of a Net-ID and a Host-ID and its 
structure is as follows:  xxx.xxx.xxx.xxx 
Range: 000.000.000.000 to 255.255.255.255  
The network administrator also defines IP addresses.  
 

The Network-ID identifies a network res. a network controller that 
administrates the network. 
The Host-ID marks the network connections of a participant (host) to this 
network.  
 

The Host-ID can be further divided into a Subnet-ID and a new Host-ID by 
using an bit for bit AND assignment with the Subnet mask.  
The area of the original Host-ID that is overwritten by 1 of the Subnet mask 
becomes the Subnet-ID, the rest is the new Host-ID. 

 
Subnet mask binary all "1" binary all "0" 
IPv4 address Net-ID  Host-ID 
Subnet mask and  IPv4 address Net-ID Subnet-ID new Host-ID 

 
A TCP-based communication via point-to-point, hub or switch connection is 
only possible between stations with identical Network-ID and Subnet-ID! 
Different area must be connected with a router. 
The subnet mask allows you to sort the resources following your needs. 
This means e.g. that every department gets an own subnet and thus does 
not interfere another department. 
 

At the first start-up of the CPU, the CP 243 of the CPU does not have an IP 
address.  
Information about the assignment of IP address data to the CP 243 may be 
found in this chapter below. 

IP address 
structure 

Net-ID 
Host-ID 

Subnet mask 

Subnet 

Address at first 
start-up  
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For IPv4 addresses there are five address formats (class A to class E) that 
are all of a length of 4 Byte = 32 Bit.  
 
Class A 0 Network-ID 

(1+7 bit) 
Host-ID (24 bit) 

Class B 10 Network-ID (2+14 bit) Host-ID (16 bit) 
Class C 110 Network-ID (3+21 bit) Host-ID (8 bit)
Class D 1110 Multicast group 
Class E 11110 Reserved 

 
The classes A, B and C are used for individual addresses, class D for 
multicast addresses and class E is reserved for special purposes. 
The address formats of the 3 classes A, B, C are only differing in the length 
of Network-ID and Host-ID. 
 
To build up private IP-Networks within the internet, RFC1597/1918 
reserves the following address areas: 

 
Network 
class 

Start IP End IP Standard subnet mask 

A 10.0.0.0 10.255.255.255 255.0.0.0 
B 172.16.0.0 172.31.255.255 255.255.0.0 
C 192.168.0.0 192.168.255.255 255.255.255.0 
(The Host-ID is underlined.) 

 
These addresses can be used as net-ID by several organizations without 
causing conflicts, for these IP addresses are neither assigned in the 
internet nor are routed in the internet. 
 

Some Host-IDs are reserved for special purposes. 
 
Host-ID = 0  Identifier of this network, reserved! 
Host-ID = maximum (binary complete 1) Broadcast address of this network 
 

Note! 
Never choose an IP address with Host-ID=0 or Host-ID=maximum! 
(e.g. for class B with subnet mask = 255.255.0.0, the "172.16.0.0" is 
reserved and the "172.16.255.255" is occupied as local broadcast address 
for this network.) 
 

Address classes 

Private IP networks 

Reserved 
Host-Ids 
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Basics - MAC address and TSAP 
 

There is a unique MAC address (Media Access Control) necessary for 
each CP. Usually a module is labeled with its MAC address by the 
manufacturer. This address should be used for project engineering of the 
CP. The MAC address has a length of 6bytes. 
On delivery the first three bytes specify the manufacturer. These bytes are 
assigned by the IEEE committee. The last three bytes may be assigned by 
the manufacturer. 
In a network several stations with the same MAC address may not exist. 
The MAC address may be changed at any time. You will get a valid MAC 
address from your network administrator. 
 

The MAC address, with which all bits are set to 1, is: 
FF-FF-FF-FF-FF-FF  
This address is used as Broadcast address and addresses all participants 
in the net.  
 
At the first-start-up the CP 343 of the CPU has an unique MAC address. 
This may be found on a label beneath the front flap. 
 

Note! 
Please regard for the configuration of the network in the Siemens SIMATIC 
manager that it is necessary to activate the ISO protocol and to preset a 
valid MAC address within the properties dialog of the Ethernet interface of 
the CP! 
 

TSAP means Transport Service Access Point. ISO transport connections 
support TSAP length of 1...16byte. TSAPs may be entered in ASCII format 
or hexadecimal. 
 

An ISO transport connection is specified by a local and a remote 
connection endpoint. 

Station A    Station B 
remote TSAP → ISO transport- → local TSAP 
local TSAP ← connection ← remote TSAP 

MAC address A    MAC address B 
 
The TSAPs of an ISO transport connection must match as follows: 
Remote TSAP (in CP) = local TSAP (in destination station) 
Local TSAP (in CP) = remote TSAP (in destination station) 
 

MAC address 

Broadcast address 

Address at first 
start-up  

     

TSAP 

Address 
parameters 
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Fast introduction 
 

At the first start-up respectively at an over all reset with an PowerON again, 
the CP 243 of the CPU does not have any IP address. The CP may only be 
reached via the MAC address. 
IP address parameters may be assigned to the CP by means of the MAC 
addresses, which may be found on a label at the side of the module. The 
assignment takes place directly via the hardware configuration of the 
Siemens SIMATIC manager. 
 

For the configuration of the CP 243 for productive connections please 
follow the following approach: 
• Commissioning and initialization  

(Assignment of IP address data) 
• Hardware configuration - CPU 
• Configure communication connections 

(Configuration via Siemens NetPro, communication via VIPA handling 
blocks)  

• PLC programming via user application (connection to PLC) 
• Transfer of the complete project to the CPU  

Information about transferring a project may be found at chapter 
"Deployment CPU ..." at "Project transfer". 

 
 

To be compatible to the Siemens SIMATIC manager, the CPU 21x-2BT13 from VIPA 
has to be configured as  

CPU 315-2DP (6ES7 315-2AF03-0AB0) V1.2 

 
The CP of the CPU 21x-2BT13 is always configured virtually as 4. module at the 
standard bus as CP343-1 (343-1EX11) from Siemens.  
To be able to address the modules they have to be projected in the hardware 
configurator from Siemens in form of a virtual PROFIBUS system. The full 
functionality of the System 200V modules is provided by inclusion of a GSD-file from 
VIPA. 
 

 
 

Overview 

Steps of 
configuration 

Note! 
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Commissioning and Initialization 
 

• Install your System 200V with your CPU.  
• Wire the system by connecting cables for voltage supply and signals 
• Connect your CP 243 with Ethernet. 
• Switch on the power supply.  

→ After a short boot time, the CP is in idle.  
At the first commissioning res. after an overall reset of the CPU, the 
CP 243 has no IP address.  

 

Please regard this functionality is available with CP firmware version 1.7.4 
and up. 
You get valid IP address parameters from your system administrator. The  
assignment of the IP address data happens online in the Siemens SIMATIC 
manager starting with version V 5.3 & SP3 with the following proceeding: 
 
• Start the Siemens SIMATIC manager. 
• Switch to "TCP/IP -> Network card .... " using Options > Set PG/PC 

interface. 
• The dialog for initialization of a station opens by PLC > Edit Ethernet 

Node. 
• To get the stations and their MAC address, use the [Browse] button or 

type in the MAC Address. The Mac address can be found at a label at 
the side of the CPU. 

• Choose if necessary the known MAC address of the list of found 
stations.  

• Either type in the IP configuration like IP address, subnet mask and 
gateway. Or your station is automatically provided with IP parameters by 
means of a DHCP server. Depending of the chosen option the DHCP 
server is to be supplied with MAC address, equipment name or client ID. 
The client ID is a numerical order of max. 63 characters. The following 
characters are allowed: "hyphen", 0-9, a-z, A-Z 

• Confirm with [Assign IP configuration]. 
Directly after the assignment the CP 243 is online reachable using the set 
IP address data. 
 

Note! 
Since the IP address data, which were assigned here, are deleted at 
PowerOFF, you have to take them to a project by means of the hardware 
configuration, which is described on the next page.   

 

Assembly and 
commissioning 

Assign IP address 
parameters 
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Hardware configuration - CPU 
 

For the project engineering of the CPU 21x and the other System 200V 
modules connected to the same VIPA bus, the hardware configurator from 
Siemens is to be used. 
To address the directly plugged peripheral modules, you have to assign a 
special address in the CPU to every module.  
The address allocation and the parameterization of the modules takes 
place in the Siemens SIMATIC manager as a virtual PROFIBUS system. 
For the PROFIBUS interface is standardized software sided, the 
functionality is guaranteed by including a GSD-file into the Siemens  
SIMATIC manager. 
Transfer your project into the CPU via the MPI interface. 
 

 

The following conditions must be fulfilled for project engineering: 
• The Siemens SIMATIC manager is installed at PC respectively PU 
• The GSD files have been included in Siemens hardware configurator 
• Serial connection to the CPU (e.g. MPI-Adapter) 
 

Note! 
The configuration of the CPU requires a thorough knowledge of the 
Siemens SIMATIC manager and the hardware configurator! 
 

• Go to www.vipa.com > Service > Download > PROFIBUS GSD files and 
download the file System_100V_-_200V_Vxxx.zip. 

• Extract the file to your work directory. The vipa_21x.gsd (German) 
respectively vipa_21x.gse (English) can be found at the directory 
CPU21x. 

• Start the Siemens hardware configurator and close every project. 
• Go to Options > Install new GSD file 
• Navigate to the directory CPU21x and choose the corresponding file 

vipa_21x.gsd (German) or vipa_21x.gse (English) 
Now the modules of the VIPA System 200V are integrated in the hardware 
catalog at PROFIBUS-DP \ Additional field devices \ I/O \ 
VIPA_System_200V. 
 
 

Overview 

Requirements 

     

Including the  
GSD-file 
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To be compatible with the Siemens SIMATIC manager the following steps 
should be executed: 
 

 

Module
CPU 21x-2BT13

Slot
0
1
...

PB-
Addr.:1

PB-
Addr.:2

(1) VIPA_CPU
CPU 21x

CPU 214

PW

S F

FC

MC

R

S

RN

ST

MR

MMC

2

Module

CPU 315-2DP 
DP

Slot
1
2
X2
3

PROFIBUS (1): DP master system (1)

 

• Start the hardware configurator from 
Siemens with a new project. 

• Insert a profile rail from the hardware 
catalog. 

• Place at slot 2 the following CPU from 
Siemens:  
CPU 315-2DP (315-2AF03 0AB00 V1.2)

• For the System 200V create a new   
PROFIBUS subnet. 

• Attach the slave system 
"VIPA_CPU21x" to the subnet with 
PROFIBUS-Address 1.  
After installing the vipa_21x.gsd the 
slave system may be found at the 
hardware catalog at PROFIBUS DP > 
Additional field devices > IO > 
VIPA_System_200V. 

• Place always at the 1. slot the 
corresponding CPU 21x-2BT13, by 
taking it from the hardware catalog. 

 
 
 
 

Since the behavior of the CP part of the CPU is the same as the CP343-1 
from Siemens, you have to place a virtual CP343-1 (Simatic300 \ CP-300 \ 
Industrial Ethernet \ CP 343-1 \ 6GK7 343-1EX11 0XE0) at slot 4 beneath  
the CPU. 
 

(1) VIPA_CPU
CPU 21x

CPU 214

PW

SF

FC

MC

R

S

RN

ST
MR

MMC

2

ModuleSlot
1
2
X2
3

PROFIBUS (1): DP master system (1)

4
5
...

CPU 315-2DP 
DP

CP343-TCP

Parameter CP

Param : .........
Param : .........
Param : .........
Param : .........

Param : .........
Param : .........
Param : .........
Param : .........

 
 
Open the property window of the CP via double-click on the CP. 
• At "General" enter a device name. The device name on the Ethernet 

subnet must be unique. 
• On [Properties] for the CP enter the IP address, subnet mask and 

gateway and select the wanted subnet. 
 

Proceeding 

Project 
engineering  
CP 243 

Parameterization of 
the IP address data 
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Configure connections 
 

The project engineering of connections i.e. the "link-up" between stations 
happens in NetPro from Siemens. NetPro is a graphical user interface for 
the link-up of stations. 
A communication connection enables the program controlled communi-
cation between two participants at the Industrial Ethernet. The communi-
cation partners may here be part of the same project or - at multi projects - 
separated within related part projects. 
Communication connections to partners outside of a project are configured 
via the object "In unknown project" or via deputy objects like "Other 
stations" or Siemens "SIMATIC S5 Station".  
The communication is controlled by the user program with VIPA handling 
blocks. To use this blocks, configured communication connections are 
always necessary in the active station. 
 

The following properties are characterizing a communication connection: 
• One station always executes an active connection establishment. 
• Bi-directional data transfer (send and receive with one connection) 
• Both participants have equal rights, i.e. every participant may initialize 

the send res. receive process event controlled. 
• Except of the UDP connection, at a communication connection the 

address of the communication partner is set via the project engineering. 
Here the connection is active established by one station.  

 
CP

send

receive

Communication
link

Ethernet partner

receive

send

send

receive

Communication
link

Ethernet partner

receive

send

.

.

.

.

.

.

.

.

.

 
 

• Siemens SIMATIC manager V. 5.1 or higher and SIMATIC NET are 
installed. 

• With the hardware configuration the CP was assigned with IP address 
data by the properties. 

 

Overview 

Properties 

Requirements 
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Note! 
All stations outside of the recent project must be configured as replacement 
objects like e.g. Siemens "SIMATIC S5" or "other station"  or with the object  
"In unknown project". 
When creating a connection you may also choose the partner type 
"unspecified" and set the required remote parameter directly in the 
connection dialog. 
 

For the project engineering of connections, a thorough knowledge with 
NetPro from Siemens is required! The following passage only describes the 
basic usage of NetPro. More detailed information about NetPro is to be 
found in the according online manual res. documentation. 
Start NetPro by clicking on a "net" in the Siemens SIMATIC manager or on 
"connections" within the CPU. 
 
The environment of NetPro has the following structure: 

1 Graphic net view 
All stations and networks are displayed in a graphic view. By clicking 
on the according component you may access and alter the 
concerning properties.  

2 Net objects 
This area displays all available net objects in a directory view. By 
dragging a wanted object to the net view you may include further net 
objects and open them in the hardware configurator. 

3 Connection table 
The connection table lists all connections in a table. This list is only 
shown when you highlighted a connectable module like e.g. a CPU. 
You may insert new connections into this table with the according 
command. 

 

 

Stationes

Subnet

+

+

Profibus-PA

Profibus-DP+

21

MPI

Ethernet

CPU
315-2

DP MPI CP
343-1

Profibus

3

Station 1
CPU
318-2

DP MPI CP
343-1

CP
343-1

Station 2

 

 

     

Work environment 
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You receive the following graphical display for every PLC station and their 
components. By selecting the single components, the context menu offers 
you several functions: 

CPU
315-2

DP MPI CP
343-1

Station 1

1

1 2 43  
1 Station 

This includes a PLC station with rack, CPU and communication 
components. Via the context menu you may configure a station 
added from the net objects and its concerning components in the 
hardware configurator. After returning to NetPro, the new configured 
components are shown.  

2 CPU 
A click onto the CPU shows the connection table. The connection 
table shows all connections that are configured for the CPU. 

3 Internal communication components 
This displays the communication components that are available in 
your CPU. For the 21xNET-CPUs are configured as CPU 315-2DP 
the internal components do not show the CP. 
Due to this, the CP that is included in the 21xNET-CPU must be 
configured as external CP at slot 4. The CP is then also shown in 
NetPro as external CP in the station. 

4 CP 
The CP 243 must always be configured as Siemens CP 343-1 in the 
hardware configuration. 

 

 

NetPro offers you the option to link-up the communicating stations. You 
may link-up the stations via the properties in the hardware configuration or 
graphically via NetPro. For this you point the mouse on the colored net 
mark of the according CP and drag and drop it to the net you want to link. 
Now the CP is linked up to the wanted net by means of a line. 
 

CPU
315-2

DP MPI CP
343-1

Station 1

Industrial Ethernet

CPU
315-2

DP MPI CP
343-1

Station 1

Industrial Ethernet

 

PLC stations 

Link up stations 
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For the project engineering of connections, open the connection list by 
selecting the according CPU. Choose Insert new connection in the context 
menu: 
 

CPU
315-2

DP MPI CP
343-1

Station 1

Insert new connection

 
 

A dialog window opens where you may choose the connection partner and 
the connection type.  
 
Each station configured in the Siemens SIMATIC manager is listed in the 
table of connection partner. These stations are unique specified by an IP 
address and a subnet mask. 
 
Here the connection partner may exist in the current project or in an 
unknown project. Connection jobs to an unknown project must be defined 
by an unique connection name, which is to be used in the projects of both 
stations. Due to this allocation the connection remains unspecified. 
 
Exclusive at UDP connections you may send to every reachable 
participant. The receipt of user data is not possible. The broadcast 
participants are specified by one port and one broadcast address at sender 
and receiver. 
Per default, broadcasts that are only serving the Ethernet communication, 
like e.g. ARP-Requests (Search MAC <> IP address), are received and 
accordingly processed. For the identification of the broadcast participants 
within the net, you have to define a valid broadcast address as partner IP 
during project engineering of a broadcast connection. Additionally to the 
broadcast address you have to set a common port for sender and receiver. 
 
By selecting All Multicast stations you define that UDP telegrams have to 
be sent res. received by all participants of a multicast group. In opposite to 
broadcast here a reception is possible. For the identification of the multicast 
participants within the net, you have to define one valid multicast group 
address and one port for sender and receiver. 
The maximum number of multicast circles, which are supported by the CP, 
is identical to the maximum number of connections. 
 
 
 

Projecting 
connections 

Connection partner 
(partner station)  

Specified 
connection partner 

Unspecified 
connection partner 

All broadcast 
stations 

All multicast 
stations 
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The following connection types are available for communication: 
• Send/Receive connections (TCP and ISO-on-TCP) for secured data 

transfer of data blocks between two Ethernet stations 
• Send/Receive UDP for not secured data transfer of data blocks 

between two stations. 
 

Choose the connection partner and the type of connection and confirm with 
[OK]. 
If activated, a properties dialog for the according connection opens as link 
to your PLC user program. 
At the following pages the relevant parameters of the different connection 
types are shortly described. More information about this may be found in 
the online help of Siemens NetPro. 
 

Insert new connection

In Project

Connections

SIMATIC 300

CPU ...

OK Apply Cancel

Connection partner

Project:        Connections
Sation:         SIMATIC 300
Module:        CPU ... 

Connection

Type:              TCP connection

 
 

After every connection was configured by this way, you may save and 
compile your project and exit NetPro. 
To store the CP project engineering data in the system data, you have to 
activate the option "Store project data in the CPU" (default setting) at object 
properties area Options in the hardware configuration of the CP. 
 
 

Connection types 

Open the 
properties dialog 

Save and compile 
connections 
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At the PLC side for data transfer with these connections the VIPA handling 
blocks AG_SEND (FC 5) and AG_RECV (FC 6) are to be used. 
 
The following connections are Send/Receive connections: 
• TCP (SEND-RECEIVE, FETCH-WRITE PASSIVE) 
• ISO-on-TCP (SEND-RECEIVE, FETCH-WRITE PASSIVE) 
• UDP (SEND-RECEIVE) 
Here the following parameters define a connection end point: 
 

remote port → TCP → local port 
local port ← connection ← remote port 

IP address A    IP address B 
 

remote TSAP → ISO-on-TCP → local TSAP 
local TSAP ← connection ← remote TSAP 

IP address A    IP address B 
 

remote port → UDP- → local port 
local port ← connection ← remote port 

IP address A    IP address B 
 
The following table shows the combination options with the different 
operating modes: 
 

Connection partner 
 

Connection type Conn. establ. Connection Operating mode 

TCP / ISO-on-TCP active/passive 
Specified in NetPro 
(in recent project) 

UDP - 
specified SEND/RECEIVE 

active specified SEND/RECEIVE 
part specified 
(Port/TSAP) TCP / ISO-on-TCP 

passive 
unspecified 

SEND/RECEIVE 
FETCH PASSIV 
WRITE PASSIV 

Unspecified in NetPro 
(in recent project) 

UDP - specified SEND/RECEIVE 

Unspecified in NetPro  
(in unknown project)  active SEND/RECEIVE 

 TCP / ISO-on-TCP 
passive 

SEND/RECEIVE 
FETCH PASSIV 
WRITE PASSIV 

 UDP - 

specified 
(connection 

name in an other 
project) 

SEND/RECEIVE 

All Broadcast stations UDP - specified (Port, 
Broadcast addr.) SEND 

All Multicast stations UDP - specified (Port, 
Multicast group) SEND/RECEIVE 

In the following each relevant parameters of the different connection types 
are described. 

Send/Receive 
connections 

Possibilities of 
combination 
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In this tab the general connection parameters are listed, which identify the 
local connection end point. 
 
This entry is identical to the entry of the connection table. The value may 
always be changed. Please also regard to adjust the ID parameter of the 
call interface of the FC. 
 
Note! 
If a CP is exchanged by another one, this must at least provide the same 
services and must at least have the same version level. Only this can 
guarantee the connections configured via the CP to remain consistent and 
useable. 
 
This field contains the name of the connection. The name is generated by 
the system and may be changed on every time. 
 
Here is the CP listed, which should be used for connection. With the button 
[Route] the appropriate CP may be selected for communication. 
 
If activated the connection to the partner is active established by the local 
station. Here the partner is to be specified in the tab "Addresses".  
At an unspecified connection the connection is passive established. 
 

Here the parameters ID and LADDR for your user program are shown. Both 
are parameters, which are to be preset if you use the FC 5 and FC 6 
(AG_SEND, AG_RECEIVE). Please always use the VIPA FCs, which you 
may receive from VIPA. 
 

The Addresses tab displays the relevant local and remote address 
information as proposed values. Depending on the kind of communication 
the address information may remain unspecified. 
 
Ports res. port addresses are defining the access point to the user 
application within the station/CPU. These must be unambiguous. A port 
address should be within the range of 2000...65535. Remote and local 
ports may only be identical with one connection.   
 
ISO-on-TCP and ISO transport support TSAP lengths (Transport Service 
Access Point) of 1 ... 16byte. You may enter the TSAP in ASCII or 
hexadecimal format. The calculation of the length happens automatically. 

General information 

ID 

     

Name 

Via CP 
[Route] 

Active connection 
establishment 

Block parameters 

Addresses 

Ports 

TSAP 
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Dependent on the specification of the connecting partner the operating 
mode may be set respectively displayed. 
 
SEND/RECEIVE 
The SEND/RECEIVE interface allows the program-controlled com-
munication to any partner station via a configured connection. Here the 
data transfer happens by a call from your user application. The FC5 and 
FC6 that are part of the VIPA block library are serving as interface. 
This enables your control to send messages depending on process events. 
 
FETCH/WRITE PASSIVE 
With the help of FETCH/WRITE services partner systems have the direct 
access to memory areas of the CPU. These are "passive" communication 
connections that have to be configured. The connections are "actively" 
established by the connection partner (e.g. Siemens-S5). 
 
FETCH PASSIVE (request data) 
FETCH allows a partner system to request data.  
 
WRITE PASSIVE (write data) 
This allows a partner system to write data in the data area of the CPU. 
 

Here every configured connections of this station and its partner are 
displayed. These data are information and may not be changed. 
 

Note! 
By appropriate shift respectively delete activities in the Siemens SIMATIC 
manager connections may lose the allocation to the CP. 
These connections are marked with "!" at ID of the overview. 
 
 

Options 

Mode 

Overview 
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SEND/RECEIVE with PLC program  
 

The following connections are Send/Receive connections: 
• TCP (SEND-RECEIVE, FETCH-WRITE PASSIVE) 
• ISO-on-TCP (SEND-RECEIVE, FETCH-WRITE PASSIVE) 
• UDP (SEND-RECEIVE) 
 
For the communication between CPU and CP, the following FCs are 
available: 
AG_SEND (FC 5) 
This block transfers the user data from the data area given in SEND to the 
CP specified via ID and LADDR. As data area you may set a PA, bit 
memory or data block area. When the data area has been transferred 
without errors, "order ready without error” is returned. 
AG_RECV (FC 6) 
The block transfers the user data from the CP into a data area defined via 
RECV. As data area you may set a PA, bit memory or data block area. 
When the data area has been transferred without errors, "order ready 
without error” is returned. 
 

Note! 
Please regard that you may only use the SEND/RECV-FCs from VIPA in 
your user application for the communication with VIPA-CPs. At a change to 
VIPA-CPs in an already existing project, the present AG_SEND/ AG_LSEND 
res. AG_RECV/AG_LRECV may be replaced by AG_SEND res. AG_RECV 
from VIPA without adjustment. Due to the fact that the CP automatically 
adjusts itself to the length of the data to transfer, the L variant of SEND res. 
RECV is not required for VIPA CPs.  
 

The CP processes send and receive commands independently from the 
CPU cycle and needs for this transfer time. The interface with the FC 
blocks to the user application is here synchronized by means of 
acknowledgements/receipts. 
For status evaluation the communication blocks return parameters that may 
be evaluated directly in the user application. 
These status displays are updated at every block call. 
 

Do not use cyclic calls of the communication blocks in OB1. This causes a 
permanent communication between CPU and CP. Program instead the 
communication blocks within a time OB where the cycle time is higher res. 
event controlled. 
 

Overview 

     

Status displays 

Deployment at high  
communication load 
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If a block is called a second time in the user application before the data of 
the last time is already completely send res. received, the FC block 
interface reacts like this: 
AG_SEND 
No command is accepted until the data transfer has been acknowledged 
from the partner via the connection. Until this you receive the message 
"Order running" before the CP is able to receive a new command for this 
connection. 
AG_RECV 
The order is acknowledged with the message "No data available yet" as 
long as the CP has not received the receive data completely. 
 

The following illustration shows a possible sequence for the FC blocks 
together with the organizations and program blocks in the CPU cycle: 
 

OB

Communication
connection

Communication
connection

Communication
connection

PIO write

PII read

User program

AG_SEND

AG_RECV

AG_RECV

AG_SEND

AG_SEND

AG_RECV

CPU cycle

 
 
The FC blocks with concerning communication connection are summarized 
by color. Here you may also see that your user application may consist of 
any number of blocks. This allows you to send or receive data (with 
AG_SEND res. AG_RECV) event or program driven at any wanted point 
within the CPU cycle.  
You may also call the blocks for one communication connection several 
times within one cycle. 
 

FC call is faster 
than CP transfer 
time 

AG_SEND, 
AG_RECV in the 
user application 
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By means of AG_SEND the data to send are transferred to the CP. 
 
 

Parameter Declaration Type Description 
ACT Input BOOL Activation of the sender 

0: Updates DONE, ERROR and STATUS 
1: The data area defined in SEND with the length LEN  
 is send 

ID Input INT Connection number 1 ... 16 (identical with ID of NetPro) 
LADDR Input WORD Logical basic address of the CP 

(identical with LADDR of NetPro) 
SEND Input ANY Data area 
LEN Input INT Number of bytes from data area to transfer 
DONE Output BOOL Status parameter for the order 

0: Order running 
1: Order ready without error 

ERROR Output BOOL Error message 
0: Order running (at DONE = 0) 
0: Order ready without error (at DONE = 1) 
1: Order ready with error 

STATUS Output WORD Status message returned with DONE and ERROR. More 
details are to be found in the following table. 

 

By means of AG_RECV the data received from the CP are transferred to 
the CPU. 
 
 

Parameter Declaration Type Description 
ID Input INT Connection number 1 ... 16 (identical with ID of NetPro) 
LADDR Input WORD Logical basic address of the CP 

(identical with LADDR of NetPro) 
RECV Input ANY Data area for the received data 
NDR Output BOOL Status parameter for the order 

0: Order running 
1: Order ready data received without error 

ERROR Output BOOL Error message 
0: Order running (at NDR = 0) 
0: Order ready without error (at NDR = 1) 
1: Order ready with error 

STATUS Output WORD Status message returned with NDR and ERROR. More 
details are to be found in the following table. 

LEN Output INT Number of bytes that have been received 
 
 

AG_SEND (FC5) 

Parameter 

AG_RECV (FC6) 

Parameter 
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The following table shows all messages that can be returned by the CP 
after a SEND res. RECV command.  
A "-" means that this message is not available for the concerning SEND 
res. RECV command. 
 

DONE 
(SEND) 

NDR 
(RECV) 

ERROR STATUS Description 

1 - 0 0000h Order ready without error 
- 1 0 0000h New data received without error 
0 - 0 0000h No order present 
- 0 0 8180h No data available yet 
0 0 0 8181h Order running 
0 0 1 8183h No CP project engineering for this order 
0 - 1 8184h System error 
- 0 1 8184h System error (destination data area failure) 
0 - 1 8185h Parameter LEN exceeds source area SEND 
 0 1 8185h Destination buffer (RECV) too small 
0 0 1 8186h Parameter ID invalid (not within 1 ...16) 
0 - 1 8302h No receive resources at destination station, receive 

station is not able to process received data fast enough 
res. has no receive resources reserved. 

0 - 1 8304h The connection is not established.  
The send command shouldn’t  be send again before a 
delay time of >100 ms. 

- 0 1 8304h The connection is not established.  
The receive command shouldn’t  be send again after a 
delay time of >100 ms. 

0 - 1 8311h Destination station not available with the defined 
Ethernet address. 

0 - 1 8312h Ethernet error in the CP 
0  1 8F22h Source area invalid, e.g. when area in DB not present 

Parameter LEN < 0 
- 0 1 8F23h Source area invalid, e.g. when area in DB not present 

Parameter LEN < 0 
0 - 1 8F24h Range error at reading a parameter. 
- 0 1 8F25h Range error at writing a parameter. 
0 - 1 8F28h Orientation error at reading a parameter. 
- 0 1 8F29h Orientation error at writing a parameter. 
- 0 1 8F30h Parameter is within write protected 1st recent data block
- 0 1 8F31h Parameter is within write protected 2nd recent data block
0 0 1 8F32h Parameter contains oversized DB number. 
0 0 1 8F33h DB number error 
0 0 1 8F3Ah Area not loaded (DB) 

continued... 

DONE, ERROR, 
STATUS 
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... continue DONE, ERROR, STATUS 
DONE 

(SEND) 
NDR 

(RECV) 
ERROR STATUS Description 

0 - 1 8F42h Acknowledgement delay at reading a parameter from 
peripheral area. 

- 0 1 8F43h Acknowledgement delay at writing a parameter from 
peripheral area. 

0 - 1 8F44h Address of the parameter to read locked in access 
track 

- 0 1 8F45h Address of the parameter to write locked in access 
track 

0 0 1 8F7Fh Internal error e.g. invalid ANY reference e.g. parameter 
LEN = 0 . 

0 0 1 8090h Module with this module start address not present or 
CPU in STOP. 

0 0 1 8091h Module start address not within double word grid. 
0 0 1 8092h ANY reference contains type setting unequal BYTE. 
- 0 1 80A0h Negative acknowledgement at reading the module 
0 0 1 80A4h reserved 
0 0 1 80B0h Module doesn’t recognize record set. 
0 0 1 80B1h The length setting (in parameter LEN) is invalid. 
0 0 1 80B2h reserved 
0 0 1 80C0h Record set not readable. 
0 0 1 80C1h The set record set is still in process. 
0 0 1 80C2h Order accumulation. 
0 0 1 80C3h The operating sources (memory) of the CPU are 

temporarily occupied. 
0 0 1 80C4h Communication error (occurs temporarily; a repetition 

in the user application is reasonable.) 
0 0 1 80D2h Module start address is wrong. 

 

At a reboot of the CP, the output parameter are set back as follows: 
• DONE = 0 
• NDR = 0 
• ERROR = 8180h (at AG_RECV) 

ERROR = 8181h (at AG_SEND) 
 

Information about transferring a project may be found at chapter 
"Deployment CPU ..." at "Project transfer". 
 
 
 

Status parameter at 
reboot 

Projekt-Transfer 
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NCM diagnostic - Help for error diagnostic 
 

This page shall help you with the error diagnostic. The following page lists a 
number of typical problems and their probable causes: 
 
Question Solution with "no" 
CPU in Run? Control DC 24V voltage supply. 

Set the operating mode switch to position RUN. 
Check PLC program and transfer it again. 

AG_SEND, AG_RECV 
in user application? 

These 2 blocks are required in the user 
application for the data transfer between CP and 
CPU. Both blocks must also be called with a 
passive connection. 

Is CP able to connect? Check Ethernet cable (at a point-to-point 
connection a crossed Ethernet cable is to be 
used). 
Check IP address. 

Can data be 
transferred? 

Check Port no. for read and write. 
Check source and destination areas. 
Check if the desired CP is selected in the route. 
Enlarge the receive res. send buffer defined via 
the ANY pointer.  

Is the complete data 
block sent at ISO-on-
TCP? 

Check the LEN parameter at AG_SEND. 
Set the receive res. send buffer defined via the 
ANY pointer to the required size. 

 

The CP supports the Siemens NCM diagnostic tool. The NCM diagnostic 
tool is part of the Siemens SIMATIC manager. This tool delivers information 
about the operating state of the communication functions of the online CPs 
dynamically.  
The following diagnostic functions are available: 
• Check operating state at Ethernet  
• Read the diagnostic buffer of the CP 
• Diagnostic of connections 
The following pages contain a short description of the NCM diagnostic. 
More details about the function range and for the deployment of the 
Siemens NCM diagnostic tool is to be found in the according online help 
res. the manual from Siemens.  
 

Check list for  
error search 

Siemens NCM  
S7 diagnostic 
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The diagnostic tool is started by Windows-START menu > SIMATIC ... 
NCM S7 > Diagnostic. 
 
The working surface of the diagnostic tool has the following structure: 
The navigation area at the left side contains the hierarchical listed 
diagnostic objects. Depending on CP type and configured connections 
there is an adjusted object structure in the navigation area.  
The information area at the right side always shows the result of the 
navigation function you chose in the navigation area. 
 

Navigation area

Module
Industrial Ethernet
Time of day
Operating mode
Diagnostic buffer
Connections

NCM-Diagnostics

Information area

...........

...........

...........

 
 
A diagnostic always requires an online connection to the CP you want to 

control. For this click at  at the symbol bar. The following dialog window 
appears: 

NCM S7-Diagnostics: Online Path

OK Cancel

Gateway

...

Destination station

Attachment ... :

Ind. Ethernet TCP/IP

Node address:                           172 . 16 . 129 . 200

Rack/Slot:                                   0         /   125

Set PG/PC Interface

 
 

Set the following parameters at destination station: 
Connection...: Ind. Ethernet TCP/IP 
Station addr.: Enter the IP address of the CP 
Module rack/slot:  
Enter the module rack 0 and slot 0. 
Set your PG/PC interface to "TCP/IP -> Network card .... ". Via [OK] you 
start the online diagnostic. 

Start NCM 
diagnostic 

Structure 

No diagnostic 
without 
connection  
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The CP has a diagnostic buffer. This has the architecture of a ring memory 
and may store up to 100 diagnostic messages. The NCM diagnostic allows 
you to monitor and evaluate the CP diagnostic messages via the diagnostic 
object Diagnostic buffer. 
Via a double click on a diagnostic message the NCM diagnostic shows 
further information. 
 

You execute a diagnostic by clicking on a diagnostic object in the 
navigation area. More functions are available via the menu and the symbol 
bar. 
 

Note! 
Please always control the preconditions for an operative communication 
using the check at the beginning of this chapter.  
 

For the aimed diagnostic deployment the following approach is convenient: 
 
• Start diagnostic. 

• Open the dialog for the online connection with , enter connection 
parameters and establish the online connection with [OK]. 

• Identify the CP and check the recent state of the CP via module status. 
• Check the connections for particularities like: 

- Connection status 
- Receive status 
- Send status 

• Control and evaluate the diagnostic buffer of the CP via diagnostic 
buffer. 

• As needed, alter project engineering res. programming and restart 
diagnostic. 

 

Read diagnostic 
buffer 

Approach for 
diagnostic 
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Coupling to other systems 
 

The operating mode FETCH/WRITE supported at TCP res. ISO-on-TCP 
can be used for accesses of partner devices to the PLC system memory. 
To be able to use this access also for example for implementation in PC 
applications you have to know the telegram structure for orders. The 
specific headers for request and acknowledgement telegrams have per 
default a length of 16Byte and are described at the following pages. 
 

The organization format is the abbreviated description of a data source or a 
data destination in a PLC environment. The available ORG formats are 
listed in the following table. 
The ERW-identifier is used for the addressing of data blocks. In this case 
the data block number is entered into this identifier. The start address and 
quantity provide the address for the memory area and they are stored in 
HIGH-/LOW- format (Motorola-formatted addresses) 
 

Description Type Range 
ORG identifier BYTE 1..x 
ERW identifier BYTE 1..255 
Start address HILOWORD 0..y 
Length HILOWORD 1..z 

 
The following table contains a list of available ORG-formats. The "length" 
must not be entered as -1 (FFFFh). 
 

ORG identifier 01h-04h 
CPU area DB MB EB AB 
ORG identifier 01h 02h 03h 04h 
Description Source/destination 

data from/into data 
Block in main 
memory. 
 

Source/destination 
data from/into flag 
memory area 

Source/destination 
data from/into process 
image of the inputs 
(PII). 

Source/destination 
data from/into process 
image of the outputs 
(PIO). 

ERW identifier 
(DBNO) 
 
 

DB, from where the 
source data is 
retrieved or to where 
the destination data is 
transferred. 
 

irrelevant irrelevant irrelevant 

Start address 
significance 
 

DBB-No., from where 
the data is retrieved or 
where the data is 
saved. 
 

MB-No., from where 
the data is retrieved or 
where the data is 
saved. 
 

IB-No., from where the 
data is retrieved or 
where the data is 
saved. 
 

QB-No., from where 
the data is retrieved or 
where the data is 
saved. 

Length 
significance 
 
 

Length of the 
source/destination 
data block in words 
 
 

Length of the 
source/destination 
data block in bytes 
 

Length of the 
source/destination 
data block in bytes 
 

Length of the 
source/destination 
data block in bytes 
 

 

Overview 

ORG format 
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Note! 
Information about the valid range can be found in the Technical data of the 
CPU. 
 

ORG identifier 05h-0Ah 

CPU area PB ZB TB 
ORG identifier 05h 06h 07h 
Description source/destination data 

from/into peripheral 
modules. Input module for 
source data, output module 
for destination data. 
 

source/destination data 
from/into counter cells. 

Source/destination data 
from/into timer cells. 

ERW identifier 
(DBNO) 
 
 

irrelevant irrelevant irrelevant 

Start address 
Significance 
 

PB-No., from where the data 
can be retrieved or where it 
is saved. 
 
 

ZB-No., from where the data 
can be retrieved or where it 
is saved. 
 

TB-No., from where the data 
can be retrieved or where it 
is saved. 
 

Length 
Significance 
 
 

Length of the 
source/destination data 
block in bytes. 
 
 

Length of the 
source/destination data 
block in words 
(counter cell = 1 word). 
 

Length of the 
source/destination data 
block in words 
(counter cell = 1 word). 
 

 

ORG identifier 81h-FFh 
To transfer data blocks of the number range 256 ... 32768 you may use the 
ORG identifier 81h-FFh.  
For the setting of a DB No. >255 needs a length of one word, the DBNOnew 
is assembled from the content of the ORG identifier and the DBNO. 
DBNOnew is created as word as follows: 
 
  DBNOnew  

High-Byte  Low-Byte 
0 X X X X X X X X X X X X X X X

 
 

ORG identifier (0XXXXXXX) 

 
 

DBNO (XXXXXXXX) 
 
If the highest bit of the ORG identifier is set, the Low-Byte of DBNOnew is 
defined via DBNO and the High-Byte of DBNOnew via ORG identifier, where 
the highest bit of the ORG identifier is eliminated.  
The following formula illustrates this:  
 
DBNOnew =256 x (ORG-identifier AND 7Fh) + DBNO 
 

     

Transfer of blocks 
with numbers 
>255 
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For every READ and WRITE the CP generates PLC header for request and 
acknowledgment messages. Normally the length of these headers is 
16Bytes and have the following structure: 
 
 

Request telegram 
Remote Station 

Acknowledgement telegram CP 

System ID ="S5" (Word) System ID ="S5"  (Word)
Length Header =10h (Byte) Length Header =10h (Byte) 
ID OP-Code =01h (Byte) ID OP-Code =01h (Byte) 
Length OP-Code =03h (Byte) Length OP-Code =03h (Byte) 
OP-Code =03h (Byte) OP-Code =04h (Byte) 
ORG block =03h (Byte) Ackn. block =0Fh (Byte) 
Length ORG block =08h (Byte) Length Ack. block =03h (Byte) 
ORG identifier*  (Byte) Error no.  (Byte) 
ERW identifier  (Byte) Empty block =FFh (Byte) 
Start address  (Word) Length empty block =07h (Byte) 
Length  (Word) 5 empty bytes attached 
Empty block =FFh (Byte) 
Length empty block =02h (Byte) 
Data up to 64kByte (only if error no.=0)

 
Request telegram 
Remote Station 

Acknowledgement telegram CP 

System ID ="S5" (Word) System ID ="S5"  (Word)
Length Header =10h (Byte) Length Header =10h (Byte) 
ID OP-Code =01h (Byte) ID OP-Code =01h (Byte) 
Length OP-Code =03h (Byte) Length OP-Code =03h (Byte) 
OP-Code =05h (Byte) OP-Code =06h (Byte) 
ORG block =03h (Byte) Ackn. block =0Fh (Byte) 
Length ORG block =08h (Byte) Length Ackn. block =03h (Byte) 
ORG identifier*  (Byte) Error no.  (Byte) 
ERW identifier  (Byte) Empty block =FFh (Byte) 
Start address  (Word) Length empty block =07h (Byte) 
Length  (Word) 5 empty bytes attached 
Empty block =FFh (Byte) 
Length empty block =02h (Byte) 

Data up to 64kByte (only if error 
no.=0) 

*) More details to the data area is to be found at "ORG-Format" above. 

 
Note! 
Please regard that in opposite to Siemens-S5 systems, the block 
addressing of these CPUs takes the start address as byte number and the 
length as number of words. 
 

The following messages can be returned via error no.: 
Error no. Message 

00h No error occurred 
01h The defined area cannot be read res. written 

 
 

Structure of PLC-
Header 

WRITE 

FETCH 

     

Messages of  
error no. 
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Example communication CPU 21xNET 
 

This chapter provides an introduction to use the TCP/IP bus system for the 
System 200V. The object of this chapter is to create a small communication 
system between two VIPA CPUs 21xNET that provides a simple approach 
to the control of the communication processes. 
 

Knowledge of the VIPA CP handling blocks AG_SEND and AG_RECV is 
required. CP handling blocks provide the options required to utilize the 
communication functions in the programs of the PLCs. 
 
The minimum technical equipment required for the example is as follows: 
 
Hardware 
 - 2 CPUs 21xNET from VIPA 
 - 1 PC or PG with Twisted Pair Ethernet connection 
 
Communication line 
 - 3 bus cables 
 - 1 Switch/Hub 
 
Addresses 
 - 2 IP Addresses and subnet masks for 2 CPs 
 
Software package 
 - SIMATIC manager from Siemens V. 5.1 or higher 
 - SIMATIC NET 
 
The implementation of the example requires that the two CPUs be 
programmed as well as the configuration of the CPs by means of NetPro 
from Siemens. 
 

Overview 

Preconditions 
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Station 1
System 200V

CPU 21xNET

Station 2
System 200V

CPU 21xNET

Ethernet

NetPro

 
 

The example for the application is based upon a communication task that is 
described in detail in the following passage: 
Both of the CPUs contain the same PLC program, only the configuration of 
the CPs have to be adjusted. 
Both stations are sending and receiving 16 data words per second. 
• Data block DB11 transfers the data bytes DBB 0 to DBB 32 at an 

interval of 1s. Data byte DBB 0 in DB 11 is used as message counter. It 
is only incremented if the preceding transmit command was processed 
correctly (completed without error). The remaining data words (DBB 2 to 
DBB 32) can be used for the transfer of user data. 

• The receiving station stores the data in DB12 (DBB 0 to DBB 31). 
• Using NetPro an active SEND/RECEIVE connection with ID 1 is to be 

configured for the CP. This Connection is established at station 2 as a 
passive SEND/RECEIVE connection. 

• The source and destination parameters must be configured directly. 
 

At this point the purpose and the required settings have been outlined. The 
programs provide additional details of the configuration of the handler 
blocks. A detailed description follows. 
 

Structure 

Station tasks 



Chapter 4   Deployment Ethernet communication Manual VIPA System 200V  

4-38  HB97E - CPU - RE_21x-2BT13 - Rev. 14/44 

The project engineering is divided into the following steps: 
• Hardware configuration 
• CP Project engineering with NetPro 
• PLC user application 
• Transfer project 
 

• Start Siemens SIMATIC manager with new project. 
• Place a new System 300 station with Insert > Station > SIMATIC 300 

station and rename it to "Station 1". 
• Activate the station "SIMATIC 300" and open the hardware configurator 

by clicking on "Hardware". 
• Configure a rack (SIMATIC 300 \ Rack-300 \ Profile rail). 
• Engineer in deputy of your CPU 21xNET the Siemens CPU 315-2DP 

with the order no. 6ES7 315-2AF03-0AB0 V1.2. which is to be found at 
SIMATIC 300 \ CPU 300 \ CPU 315-2 DP \ 6ES7 315-2AF03-0AB0. If 
needed, parameterize the CPU 315-2DP. 

• Configure in deputy of your CP the CP 343-1 (343-1EX11) from 
Siemens at slot 4, to be found at SIMATIC 300 / CP 300 / Industrial 
Ethernet / CP 343-1. 

• Set IP address, subnet mask and gateway at "CP properties".  
 
Here it is not necessary to configure the System 200V modules by means 
of a virtual PROFIBUS system. 
 

Create, following the approach above, a hardware configuration for the 
destination CPU and assign the name "Station 2". 
For the CP, use the IP addresses, subnet masks and gateways assigned to 
Station 2.  
Save and compile your project. 
 

Steps of project 
engineering 

Hardware 
configuration 
Station 1 

Hardware 
configuration 
Station 2 
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Start NetPro by selecting the CPU below Station 1 and clicking on the 
object "connections".  
In NetPro "Station 1" and "Station 2" are listed together with Ethernet. 
 

Ethernet

CPU
315-2

DP MPI CP
343-1

Station 1
CPU
315-2

DP MPI CP
343-1

Station 2

 
 
To configure the connection open the connection list. For this you choose 
the CPU of Station 1 and call Insert new connection via the context menu: 

CPU
315-2

DP MPI CP
343-1

Station 1

Insert new connection

 
A dialog window appears where you can select the connection partner and 
the type of the connection.  
Configure the following connection: 
 
New connection 

Connection:  TCP connection 
Connection partner: Station 2 > CPU 315-2 

 
Properties TCP connection 

ID:  1 
ID and LADDR are parameters that you have to define in 
your PLC program if using FC5 (AG_SEND) and FC6 
(AG_RECEIVE). 

Route:  The Route allows you to choose the CP that has to 
manage the connection.  

  For the communication between the CPU 21xNET the 
route "CP 343-1 - (R0/S4)" is just right preset. 

Active connection establishment: activated 
 
Save and compile your connection. 
 

Project engineering 
with NetPro 
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For the processing of connection commands at the PLC, a PLC user 
program is necessary in the concerning CPU. For this only the handling 
blocks AG_SEND (FC5) and AG_RECV (FC6) are used. By including this 
blocks into the cycle block OB1 with the parameters ID and LADDR you 
may cyclically send and receive data.  
The two FCs are part of the VIPA library that is included in the consignment 
of the CPU as CD. 
 
Via the cycle OB OB1 the sending and receiving of the data is controlled. 
The OB1 that you may transfer into both CPUs has the following structure: 
 
UN    T      1 // Timer 1 triggered sending 
L     S5T#1S // Send initiation every 1 sec 
SV    T      1 
S     M     10.0 // Init bit memory 
CALL  "AG_SEND" 
ACT   :=M10.0 // Init bit memory 
ID    :=1 // Connection number 
LADDR :=W#16#110 // Module address 
SEND  :=P#DB11.DBX0.0 BYTE 100   // Send buffer area DB11 
LEN   :=32 // Send 32 Byte (16 Words) from DB11  
DONE  :=M10.1 
ERROR :=#Senderror // Temporary error bit memory 
STATUS:=MW12 // Order res. connection state 
U     M     10.1 // Send ready? 
SPBN  nDon 
U     M     10.1 // Send ready? 
R     M     10.0 // Set back init 
U     #Senderror // At send error 
SPB   nDon // Don’t raise send counter 
L     DB11.DBW    0 // Send counter in user data (DBW0) 
L     1 // increment for 1 and  
+I // store again in send buffer 
T     DB11.DBW    0   
 

nDon: NOP   0 // Send not ready yet 
 
// Cyclic call of the receive block 
 
CALL  "AG_RECV" 
ID    :=1 // Connection number 
LADDR :=W#16#110 // Module address 
RECV  :=P#DB12.DBX100.0 BYTE 32 //Receive buffer 
NDR   :=#Newdata // NewDataReceived? 
ERROR :=M0.1 // RecError 
STATUS:=MW2 // Order res. connection state 
LEN   :=#Reclen // Really received length 
NOP   0 // Reclen can be at IsoOnTCP < 32 
U     #Newdata // when new data received 
ZV    Z      1 // Increment Receive counter Counter1 
L     Z      1 // reset counter 1 at overflow 
L     999 
==I    
R     Z      1 

 
 

PLC user program 

OB 1 
Cycle 
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It is assumed, that the CPs are programmed and that an overall reset was 
issued to the CPUs, where the RUN/STOP switch must be located in STOP 
position. 
Now load the above PLC programs into both CPUs and switch them into 
RUN. 
Start the Siemens SIMATIC manager and execute the following steps to 
monitor the transmit job: 
• PLC > Monitor/Modify Variables 
• In the column "Operand" you have to enter the respective data block 

number and the data word (DB11.DBB 0-31). 

• Establish a connection and click "monitor" . 
 

 
 

You may enter user data starting with DBB2. Place the cursor on modify 
value and enter the value you wish to transfer, e.g. W#16#1111. 

The  button transfers the modify value in every cycle and the  button 
initiates a single transfer. 
 
 
 

Monitoring the 
data transfer in the 
Siemens SIMATIC 
manager  

Entering User data 



Chapter 4   Deployment Ethernet communication Manual VIPA System 200V  

4-42  HB97E - CPU - RE_21x-2BT13 - Rev. 14/44 

 


	HB97E_CPU 21x-2BT13
	Contents 
	About this manual 
	Safety information

	01 Basics and Assembly
	Safety Information for Users
	System conception
	Dimensions
	Installation
	Demounting and module exchange
	Wiring
	Installation guidelines
	General data

	02 Hardware description
	Properties
	Structure
	Technical Data

	03 Deployment CPU 21x-2BT13
	Assembly
	Start-up behavior
	Addressing
	Hints for the deployment of the MPI interface
	Hardware configuration -CPU
	Hardware configuration -I/ O modules
	Hardware configuration -Ethernet PG/ OP channel
	Setting CPU parameters
	Project transfer
	Operating modes
	Overall reset
	Firmware update
	Factory reset
	VIPA specific diagnostic entries
	Using test functions for control and monitoring of variables

	04 Deployment Ethernet communication
	Basics -Industrial Ethernet in automation
	Basics -ISO/ OSI reference model
	Basics -Terms
	Basics -Protocols
	Basics -IP address and subnet
	Basics -MAC address and TSAP
	Fast introduction
	Commissioning and Initialization
	Hardware configuration -CPU
	Configure connections
	SEND/ RECEIVE with PLC program
	NCM diagnostic -Help for error diagnostic
	Coupling to other systems
	Example communication CPU 21xNET


